(Eridgemate) | |

Bridgemate Il Scoring system
Manual

Chapter 8: Using Bridgemates with ACBLscore

 Bridgemate normally
operated by North

o When “Verification
by East or West"
appears, East or
West must verify.

o Traveler should be
viewed by all

Bridgemate silently.

© 2004-2011 Bridge Systems BV

Adapted for North American use
Bridgemate.US, LLC — 2011



All information contained in this document is subject to change without prior warning. Unless stated otherwise, all
persons and details mentioned in this document are fictitious. No part of this publication may be reproduced and/or

published, by print, photoprint, microfilm or otherwise, or stored in a retrieval system, without prior written permission
from Bridge Systems BV.

© Copyright 2004-2011 Bridge Systems BV. All rights reserved.

Bridgemate, Bridgemate Pro, Bridgemate Il and the Bridgemate logo are trademarks and/or registered trademarks of
Bridge Systems BV in the Netherlands and other countries. Microsoft and Microsoft Windows are trademarks and/or
registered trademarks of the Microsoft Corporation in the United States and other countries.

Every user should read and take notice of the Safety Instructions printed on page 3 of this manual.

Customers who have concerns with the Bridgemate Control Software End User License Agreement (displayed when
Bridgemate Control Software is installed) and/or the Bridgemate Scoring System Limited Warranty (pages 1 and 2 of
this manual) may return unused products at the customer’s expense to Bridgemate.US, LLC, for a full refund of the
purchase price — excluding shipping charges.

Bridgemate.US, LLC
350 Sawmill Creek Dr.
Nellysford, VA 22958
434-361-1397
FAX: 434-361-0220
sales@bridgemate.us
www.bridgemate.us



mailto:sales@bridgemate.us
http://www.bridgemate.us/

Table of Contents

LIMITED WARRANTY 1
SAFETY INSTRUCTIONS 3
INTRODUCTION 4
CHAPTER 1: DESCRIPTION BRIDGEMATE Il SCORING SYSTEM 5
DESCRIPTION OF COMPONENTS 5
PROCEDURE 6
CHAPTER 2: HARDWARE CONFIGURATION 8
SYSTEM REQUIREMENTS 8
INSTALLING BRIDGEMATE CONTROL SOFTWARE (BCS) 8
INSTALLING THE SERVER 8
INSTALL DRIVER AND CONNECT USB SERVER 8
POWER SUPPLY THROUGH USB PORT AND BATTERIES 8
SETTING THE REGION 9
SETTING THE CHANNEL 9
CONFIGURING THE BRIDGEMATES 9
OPERATING INSTRUCTIONS 9
CHAPTER 3: BRIDGEMATE CONTROL SOFTWARE 10
LAUNCHING BRIDGEMATE CONTROL SOFTWARE 10
LOGGING IN AND LOGGING OFF BRIDGEMATES 11
LOGGING IN BRIDGEMATE 11
LOGGING OFF BRIDGEMATE 11
BOARD RESULTS 12
READING FROM THE SERVER 12
VIEWING AND FILTERING OR SORTING SCORES 12
CREATING REPORTS 12
CHANGING AND DELETING BOARD RECORDS 13
PROCESSING SCORES IN THE SCORING PROGRAM 13
OPENING AND CLOSING RESULTS FILES 13
USING MULTIPLE CLIENTS 14
ADDING A CLIENT TO THE RESULTS FILE 14
MANAGING TABLES — TOURNAMENT (NETWORK) MODE 14
SERVER CONTROL 15
ACTIVATING THE SERVER 15
ADDING TABLES 15
REMOVING TABLES 15
SYNCHRONIZING THE SERVER AND CLIENT 15
RECOVERING THE SERVER 16
UPDATING MOVEMENT IN THE SERVER 16
CLOSING ROUNDS 16
PROGRAM SETTINGS (OPTIONS) 17
CHAPTER 4: SERVER FUNCTIONS 18
OVERVIEW OF TABLES 18
OVERVIEW OF ENTERED SCORES 18
RESTARTING BRIDGEMATE NETWORK 18
RESETTING THE SERVER 18
SETTING THE REGION 19
SETTING THE CHANNEL 19



SYSTEM FUNCTIONS 19
USB SERVER LIGHTS 19
PROGRAM SHUTDOWN — POWER OUTAGES — CHANGE PC 19
CHAPTER 5: USE OF THE BRIDGEMATE® Il SCORING DEVICES 20
EXPLORING THE BRIDGEMATE 20
ACTIVATING THE BRIDGEMATE 21
CONFIGURING THE BRIDGEMATE 21
STARTING THE SESSION 22
ENTER RESULTS WITH THE BRIDGEMATES 23
RANKING AND GAME SUMMARY 25
REVIEWING SCORES AND RECTIFYING SCORES 25
PoOSTING BRIDGEMATE Il SCORES 26
TD MENU 26
CHAPTER 6: ADDITIONAL BRIDGEMATE FUNCTIONS 28
BRIDGEMATE SETTINGS 28
SHOWING PLAYER NAMES 29
HAND RECORDS 30
UPDATE SETTINGS DURING PLAY 30
UPDATING BRIDGEMATE FIRMWARE 30
SAVING THE .BWS (RESULTS) FILE 31
REAL-TIME PUBLICATION 31
CHAPTER 7: TIPS FOR USE 32
BRIDGEMATE LOGGED ON AS THE WRONG TABLE 32
REPLACING BRIDGEMATE 32
RECOVERING THE SERVER 32
PROCEDURE IN THE EVENT OF DATA LOSS 32
RESENDING RESULTS 33
MULTIPLE BRIDGE CLUBS PLAYING SIMULTANEOUSLY 34
LARGE TOURNAMENTS 34
USING ACBLSCORE AND BRIDGEMATES ON A NETWORK 34
CHAPTER 8: USING BRIDGEMATES Il WITH ACBLSCORE 35
INSTALLATION 35
SOFTWARE REQUIRED 35
INSTALL SOFTWARE 35
CONNECT THE BRIDGEMATE SERVER TO THE COMPUTER. 35
BCS SETuUP 35
ACBLSCORE SETUP 36
READ DATA FROM THE BRIDGEMATE SCORING SYSTEM INTO ACBLSCORE. 37
PLAYER NUMBERS 37
BOARD RESULTS 38
QUICK SETUP TIPS 38
CHANGE MOVEMENT AFTER GAME HAS STARTED 38
CHANGE BEFORE ANY BRIDGEMATES HAVE BEEN USED 39
CHANGE AFTER PEOPLE HAVE STARTED MEMBER NUMBER AND/OR SCORE ENTRY 39
REPLACING BRIDGEMATE DURING PLAY — BRIDGEMATE LOGGED ON AS THE WRONG TABLE 39
ACBLSCORE TOURNAMENT SETUP 39
PROCEDURES WHEN USING PLAYER ENTRY OF SECTION/TABLE 39
NAMES DISPLAY FOR 1°" ROUND SIT-0UT PAIR[S] 40
SPECIAL REPORTS 40
EXPANDED DETAIL AVAILABLE ON WEBSITES. 40
USING BRIDGEMATES || AND BRIDGEMATES PRO TOGETHER 41
DECLARATION OF CONFORMITY 42




Limited warranty 1

Limited warranty

IMPORTANT—PLEASE READ THIS LIMITED WARRANTY CAREFULLY TO UNDERSTAND YOUR RIGHTS AND
OBLIGATIONS! The term “Hardware Device” means the Bridge Systems hardware product. The term “You” means
either an individual or a single legal entity who will be referred to in this Limited Warranty as “You” and “Your”.

A. WARRANTIES.

1. Express Warranty. Subject to the terms and conditions of this Limited Warranty and in lieu of any other (if
any) express warranties, Bridge Systems warrants that under normal use and service, on the date of acquisition as
shown on Your receipt or similar proof of payment and for the period of time stated below for the applicable
Hardware Device (hereafter each defined as the “Warranty Period”), that the Hardware Device will substantially
conform with the accompanying Bridge Systems packaging and documentation. As to any defects discovered after
the Warranty Period, there is no warranty or condition of any kind.

Warranty Period:
For all hardware parts of the Bridgemate Scoring System: one (1) year.

This Limited Warranty does not cover, and no warranty of any kind is provided with respect to any subjective or
aesthetic aspects of the Hardware Device. The express warranty stated above is the only express warranty made to
You and is provided in lieu of all other express or implied warranties and conditions (except for any nondisclaimable
implied warranties that exist), including any created by any other documentation or packaging. No information or
suggestions (oral or in a record) given by Bridge Systems, its distributors, agents, affiliates or suppliers or its or their
employees or agents, shall create a warranty or condition or expand the scope of this Limited Warranty.

2. Limitation on Duration of Implied Warranties. If you are a consumer, You may also have an implied warranty
and/or condition under the laws of some jurisdictions, which is hereby limited to the duration of the Warranty Period.
Some jurisdictions do not allow limitations on how long an implied warranty or condition lasts, so the foregoing
limitation may not apply to You.

B. EXCLUSIVE REMEDY. Subject to applicable law and the following, and provided that You return the
Hardware Device to Your place of acquisition (or, if that place will not accept the return, to Bridge Systems) with a
copy of Your receipt or other bona fide proof of payment during the Warranty Period, Bridge Systems will, at its
option and as Your exclusive remedy for breach of this Limited Warranty and any implied warranties:

repair or replace the defective Hardware Device; or make payment to You for the allowable damages that You
incurred in reasonable reliance, but only up to the amount You paid (if any) for the Hardware Device less reasonable
depreciation based on actual use.

The above remedy is subject to the following:

Any repaired or replaced Hardware Device will be new or refurbished or serviceably used, comparable in function
and performance to the original Hardware Device, and may include third party items;

Any Hardware Device repaired or replaced under this Limited Warranty will be warranted for the remainder of the
original Warranty Period or 30 days from the date of shipment of the item back to You, whichever is longer.

Except as otherwise required by legislation in Your jurisdiction, costs associated with transport (including packaging)
for warranty service shall be at Your expense; and Bridge Systems, its distributors, agents, affiliates and suppliers do
not provide any warranties regarding any other services provided under this Limited Warranty and disclaim all duties
(if any) of workmanlike effort or of lack of negligence regarding such services.

C. NO OTHER WARRANTIES. The express warranty stated above is the only express warranty made to You
and is provided in lieu of all other express or implied warranties and conditions (if any) including any created by any
other documentation or packaging. No other warranties or conditions are made with respect to the Hardware Device
or the warranty services by any person, including but not limited to Bridge Systems, its distributors, agents, affiliates
and suppliers. No information (oral or written) or suggestions given by Bridge Systems, its distributors, agents or
suppliers or its or their employees, shall create a warranty or condition or expand the scope of this Limited Warranty.
Also, there is no warranty or condition of title, quiet enjoyment, or noninfringement in the Hardware Device. You may
have greater rights existing under legislation in your jurisdiction.
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D. EXCLUSION OF OTHER DAMAGES.

TO THE FULL EXTENT ALLOWED BY LAW, BRIDGE SYSTEMS AND ITS DISTRIBUTORS, AGENTS,
AFFILIATES AND SUPPLIERS ARE NOT LIABLE FOR ANY:

(i) CONSEQUENTIAL OR INCIDENTAL DAMAGES;

(i) DAMAGES OR LOSS OF ANY NATURE WHATSOEVER RELATING TO LOST PROFITS, BUSINESS
INTERRUPTION, LOSS OF DATA OR PRIVACY OR CONFIDENTIALITY, ANY INABILITY TO USE ALL OR PART
OF THE HARDWARE DEVICE, PERSONAL INJURY, OR ANY FAILURE TO MEET ANY DUTY (INCLUDING BUT
NOT LIMITED TO ANY DUTY OF NEGLIGENCE, GOOD FAITH OR OF WORKMANLIKE EFFORT); OR

(iii) INDIRECT, SPECIAL, OR PUNITIVE DAMAGES ARISING OUT OF OR RELATING IN ANY WAY TO THE
HARDWARE DEVICE. THE FOREGOING APPLIES EVEN IF BRIDGE SYSTEMS OR ANY DISTRIBUTOR,
AGENT, AFFILIATE OR SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSSES OR
DAMAGES; AND EVEN IN THE EVENT OF FAULT, TORT (INCLUDING NEGLIGENCE), STRICT OR PRODUCT
LIABILITY, MISREPRESENTATION OR OTHER REASON.

Some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above
limitation or exclusions may not apply to You.

E. EXCLUSIONS FROM COVERAGE. This Limited Warranty shall not apply and Bridge Systems, its
distributors, agents, affiliates and suppliers have no liability under this Limited Warranty if the Hardware Device:
- is used for commercial purposes (including rental or lease);

- is modified or tampered with;

- is damaged by Acts of God, power surge, misuse, abuse, negligence, accident, wear and tear, mishandling,
misapplication, or other causes unrelated to defects in the Hardware Device;

- is damaged by programs, data, viruses, or files, or during shipments;

- is not used in accordance with the accompanying documentation and use instructions; or

- is repaired, modified or altered by other than a Bridge Systems authorized repair center and the unauthorized
center causes or contributes to any defect or damage.

F. REGISTRATION. You need not register Your acquisition of the Hardware Device for the Limited Warranty to
be effective.

G. BENEFICIARY. To the extent allowed by applicable law, the Limited Warranty is only made to You, the first
purchaser of the Hardware Device, and there are no third party beneficiaries of the Limited Warranty. It is not
intended for and does not apply to anyone else (except as required by law), including anyone to whom You make
any transfer of the Hardware Device.

H. FURTHER INFORMATION. Bridge Systems is the warrantor under this Limited Warranty. To receive
instructions for obtaining performance of this Limited Warranty You must either contact the local Bridgemate
distributor serving your country, or write to: Bridge Systems BV, Postal Box 21570, Rotterdam, 3001 AN, The
Netherlands, or visit Bridge Systems on the World Wide Web at www.bridgemate.com.

You must also:

1. Submit proof of payment in the form of a bona fide, dated receipt, or invoice (or a copy) evidencing that You are
the beneficiary of this Limited Warranty and that Your request for a remedy is made within the Warranty Period;

2. Follow Bridge Systems’ shipping and other instructions if it determines that all or part of your Hardware Device
requires return. To obtain the Limited Warranty performance, you must take or deliver the item in either its original
packaging or packaging that provides an equal degree of protection to the location specified by Bridge Systems.
Except as otherwise required by legislation in your jurisdiction, costs associated with transport (including packaging)
for warranty service shall be at Your expense.

Failure to follow the above instructions may result in delays, cause you to incur additional charges, or may void your
warranty.

This Limited Warranty gives You specific legal rights and You may also have other rights which vary from jurisdiction
to jurisdiction. Where any term of this Limited Warranty is prohibited by such laws, it shall be null and void, but the
remainder of the Limited Warranty shall remain in full force and effect if its allocation of risks is not materially
disturbed.
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Safety instructions

Important safety warning

Failure to properly set up, use, and care for the Bridgemate system can increase the risk of serious injury or death, or damage to the system.
Read this manual and the manuals of any peripherals for important safety and health information. Keep all manuals for future reference. For
replacement manuals, go to www.bridgemate.us/User Guides.php or contact Bridgemate.US.

Select a safe location for the Bridgemate server and scoring devices
If the Bridgemate Pro server or Bridgemate Pro scoring devices falls and hits someone, it could cause serious injury. To reduce the risk of
such injuries and damage to parts of the system, set them up according to these instructions and place them on a surface that:
e Isflatand level.
Is stable and not likely to tip over.
Allows all four feet of both the server and scoring device to be in contact with the surface.
Is not likely to allow the server and scoring device to slip or slide off.
Is clean and free of dust and debris.

If the surface or feet of server or scoring devices become dirty or dusty, clean them with a dry cloth.

Arrange all cables and cords so that people and pets are not likely to trip over or accidentally pull on them as they move around or walk
through the area. When the Bridgemate server is not in use, you may need to disconnect all cables and cords from the server to keep them
out of the reach of children and pets. Do not allow children to play with cables and cords.

Do not place any part of the Bridgemate system on a bed, sofa, or other soft surface. Do not place any part near heat sources, such as
radiators, heat registers, stoves, or amplifiers.

Avoid smoke and dust: Do not use the Bridgemate Scoring system in smoky or dusty locations. Smoke and dust may damage the
Bridgemate server and scoring devices.

Insert batteries into the Bridgemate Il scoring devices and server

WARNING Improper use of batteries may result in battery fluid leakage, overheating, or explosion. Released battery fluid is corrosive

and may be toxic. It can cause skin and eye burns, and is harmful if swallowed. To reduce the risk of injury:

Keep batteries out of reach of children.

Do not heat, open, puncture, mutilate, or dispose of batteries in fire.

Do not mix new and old batteries or batteries of different types (e.g., carbon-zinc and alkaline batteries)

Remove the batteries if they are worn out or before storing your Bridgemate system for an extended period of time. When removing

batteries from the Bridgemate or server do not use your fingers or finger nails to remove the batteries; use a blunt object like a

screwdriver or pen to safely remove the batteries.

o Ifabattery leaks, remove all batteries, taking care to keep the leaked fluid from touching your skin or clothes. If fluid from the battery
comes into contact with skin or clothes, flush skin with water immediately. Before inserting new batteries, thoroughly clean the battery
compartment with a damp paper towel, or follow the battery manufacturer's recommendations for cleanup.

o  Dispose of batteries in accordance with Local and National Disposal Regulations, including those governing the recovery and recycling
of waste electrical and electronic equipment (WEEE).

Remove batteries aboard aircraft
Before boarding any aircraft or packing Bridgemate scoring devices or server in luggage that will be checked, remove all batteries. The
Bridgemate server and terminals can transmit radio frequency (RF) energy, much like a cellular telephone, whenever batteries are installed.

Do Not Attempt Repairs
Do not attempt to take apart, service, or modify the Bridgemate server, Bridgemate Pro scoring devices, power supply, or its peripherals in any
way. Doing so could present the risk of serious injury or death from electric shock or fire, and it will void your warranty.

Any evidence of any attempt to open and/or modify the Bridgemate Pro system, including any peeling, puncturing, or removal of any of the
labels, will void the Limited Warranty and render the Bridgemate Pro system ineligible for authorized repair.

Disposal of Waste Electrical and Electronic Equipment in the European Union and

other countries/regions with separate collections systems

This symbol on the product or its packaging means that this product must not be disposed of with household waste. Instead,

it is your responsibility to hand this over to an applicable collection point for the recycling of electrical and electronic .
equipment. This separate collection and recycling will help to conserve natural resources and prevent potential negative

consequences for human health and the environment, which inappropriate disposal could cause due to the possible presence of hazardous
substances in electrical and electronic equipment. For more information about where to drop off electrical and electronic waste, contact your
local city/municipality office, your household waste disposal service, or the shop where you purchased this product.
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Introduction

Thank you for purchasing your Bridgemate® Il scoring system. Bridgemate Il is an advanced electronic scoring
system for bridge clubs and tournaments, designed to enhance the enjoyment of bridge. Bridgemate Il automatically
registers board results. The scores are verified and fed to the central PC. Tournament directors will value the user-
friendly features of Bridgemate I, as it enables them to focus fully on their core tasks.

This manual describes the operation of the Bridgemate Scoring system, including the central software program, the
server and the Bridgemate scoring devices. This manual serves as an addition to the manual supplied with your
scoring program. As the Bridgemate Scoring system operates independently from the scoring program, this manual
includes instructions for operating ACBLscore — but not other scoring programs.

This manual consists of the following chapters:

The components of the Bridgemate Scoring system are explained in Chapter 1. A brief and concise explanation is
given of the individual components and how they relate to each other.

Chapter 2 explains how to configure and install the Bridgemate Il software and hardware and how to configure the
Bridgemates per section and table. This chapter also explains how to set the radio channels to enable wireless data
exchange.

Chapter 3 explores the use of the Bridgemate Control Software in more detail.

Chapter 4 explains the different Bridgemate Control Software options offered by the Bridgemate Il server.

Use of the Bridgemate Il scoring devices is explained in Chapter 5.

Chapter 6 highlights the additional functions for the Bridgemate.

Chapter 7 contains tips on how to operate the Bridgemate Il scoring system when multiple bridge clubs are playing
simultaneously in one room. Practical advice is also offered on how to deploy Bridgemate Il in big tournaments,
involving different rooms and/or multiple servers.

Chapter 8 describes using the Bridgemate system with ACBLscore.

Version numbers
This manual covers the following versions of the Bridgemate Il components:

Bridgemate Control Software 2.6.1
Bridgemate USB server 1.3.107d (firmware version)
Bridgemate Il scoring devices 1.6.1 (firmware version)

Download Software and Firmware

Updates of the Bridgemate firmware can be downloaded from www.bridgemate.us/support.php
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Chapter 1. Description Bridgemate Il scoring system

This chapter describes the components of the Bridgemate 1l scoring system and how they relate to each other. It
also explains how to use the Bridgemate II: from creating a session in your scoring program to registering the scores
in the scoring program.

Please read this chapter carefully. Once you understand the function of the individual components and how they
relate to each other, you will quickly get to grips with the Bridgemate Il scoring system.

Description of components

The Bridgemate |l scoring system consists of the following hardware and software:

Bridgemate Il scoring devices

Bridgemate Il server + USB cable

Data cable for connection between Bridgemate terminals and the server
Bridgemate Control Software

() N —
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Bridgemate Il Scoring Device Bridgemate Il Server + USB Cable Data cable

Bridgemate Il scoring devices

The Bridgemate 1l scoring devices are placed on the bridge table and are used to enter the results. For the purpose
of simplicity, we shall refer to these input devices as "Bridgemates”. Wireless communication between the
Bridgemates and the server is established and maintained using radio frequency waves. Only one Bridgemate is
required per table. The use of the Bridgemates is explained in more detail in Chapter 5.

Bridgemate Il server

The Bridgemate |l server, “server” for short, is a small device connected to the PC. It acts as a bridge between the
PC and the Bridgemates. As the PC cannot communicate directly with the Bridgemates, the server is a vital
component. The server is equipped with a transmitter and a receiver, establishing and maintaining wireless data
communication with the Bridgemates. The server sends all movement data to the Bridgemates, including board
numbers and pair numbers, and receives the board results in return. The server can control up to 256 Bridgemates
simultaneously. The server connects to the computer using aUSB cable.

Data cable

Both the USB server and Bridgemates Il are equipped with a small round connectort. The devices can be connected
to each other by using the small data cable which is supplied with the USB server. This wired connection can be
used for hardware analysis of the Bridgemate device. This cable is only required in the rare occasion of a hardware
failure and is not used during normal operations

Bridgemate Control Software

A specific program is required to control the server from the PC: Bridgemate Control Software (BCS). This program
runs on Windows 2000 SP3 or higher and is controlled in part by your scoring program. BCS fully controls the server
and data exchange between the server and the PC. BCS first saves all the relevant session data used by the server
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to control the Bridgemates. BCS then retrieves all entered board results from the server and stores these in the
results file. All other server controls are also executed from BCS.

In addition, the following three components are important. Although they are not supplied together with your
Bridgemate Il scoring system, they are of crucial importance to the correct operation of the system.

Client (=Personal computer with Bridgemate Control Software)
Results file
Scoring program

Client

Bridgemate Control Software runs on a so-called “client” (Windows-based) personal computer (PC). The scoring
program and BCS usually run on one client PC, to which the server is also connected. During big tournaments,
multiple servers may be required to support the high number of Bridgemates and/or to establish and maintain the
wireless communication between the server and the Bridgemates. In this case, the servers are connected to a
network PC, and the network consists of multiple clients.

Note: The term “client” suggests that the Bridgemate |l scoring system also consists of a PC network server. This is
not the case. All (network) PCs running the Bridgemate Il scoring system are known as clients.
Results file

The results file is created by the scoring program. It contains all the session data, including sections, tables,
movements, etc. This data is generated by the session configured in the scoring program. BCS reads this session
data and feeds the correct data to the server. During the session, BCS reads all the board results entered in the
server and saves these in the results file. All Bridgemate Il results files have the file extension .bws.

Scoring program

The scoring program creates the session and calculates the scores. After you have created a session, the scoring
program will create the abovementioned results file. This file contains all the relevant session data. The scoring
program will read all board results saved in the results file and process these during the session. These procedures
are explained in more detail in the user manuals or help files of your scoring program.

Procedure

Having examined the individual components of the Bridgemate Il scoring system, the next step involves assessing
the entire process and how the different components relate to each other.

The process is outlined in the below diagram:

Activity Explanation

This is the starting point in the process. In the session, users can set
the number of sections to be played, the number of pairs per section,
boards and movements.

Step 1: Session created in the
scoring program

Using the session data, the scoring program creates a results file,
containing all data relating to the sections, corresponding movements,
boards and pairs.

Step 2: Results file created in the
scoring program

Step 3: Bridgemate Control Software The scoring program starts BCS. The results file is then read by BCS,
reads the results file generating the data for all tables used in each session.
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Step 4: Bridgemate Control Software
transfers data to the server

Step 5: The server has been
activated and the Bridgemates can
be activated

Step 6: Scores are entered in the
Bridgemate and sent to the server

Step 7: Bridgemate Control Software
retrieves the scores from the server.
The scores are saved in the results
file

Step 8: The scoring program reads
the scores saved in the results file
and adds these to the session

BCS initializes the server using the data contained in the results file. All
session tables are stored in the server. Movements from each table are
included, so that the server knows (per round) which pairs and boards
correspond with which table.

Now that all the relevant data has been stored in the server, the
Bridgemates can be activated. The players activate the Bridgemates,
which log in to the server. The scores can now be entered.

During this process, the board number and pair number/direction of play
are verified for accuracy. Verification is executed via direct
communication between the Bridgemate and the server. The
Bridgemate itself does not contain any movement data. Entered board
results are sent directly to the server. This data is stored in the server
memory.

BCS reads all newly entered scores from the server and saves them in
the results file.

The scoring program reads the scores saved in the results file and
stores these in its session file. The scores are processed and
incorporated in the session data to calculate the final score.

Automatic launch from your scoring program

If your scoring program fully supports Bridgemate, BCS can execute steps 2 to 4 and read the scores (step 7)
automatically via one simple command from the scoring program. For further information on how to enable
automatic launch of the Bridgemate Il scoring system, please contact the supplier of your scoring program.
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Chapter 2: Hardware configuration

System requirem ents
Operating system
The Bridgemate Scoring System needs Windows2000 SP3 or higher.

Hardware Recommended configuration: Processor Pentium Il 600MHz or higher
Memory 128MB or higher

Installing Bridgemate Control Software (BCS)

To install the Bridgemate Scoring System, run the current “BCSsetup.exe” file. This software is on the Flash
Drive/Memory Stick from Bridgemate.US; also, it may be downloaded from Bridgemate.US’s website
www.bridgemate.us/support.php or the Bridgemate Developer's www.bridgemate.com/support website. The
requirements for installing BCS software may differ, depending on your scoring program. For more information about
where to install the software on your PC, please consult the information supplied with your scoring program or by
your Bridgemate supplier. To install BCS on a separate client, we recommend the default folder (C:\Program
Files\Bridgemate Pro).
Special Note for Vista and Windows 7 PC’s: Windows 7 and Vista security precautions inhibit writing to the BCS
log file when it is located in the default C:\Program Files\Bridgemate Pro folder or the “root” C:\. Therefore, the BCS
software option should be configured to save the Bridgemate Log File elsewhere, e.g.,e C:\ACBLSCOR.

See Log file settings on Page 17 for specific details.

The BCS installation program will ask if it may also install the driver needed for the USB Server; answer “yes” to this.
Installing the server

Install driver and connect USB server
Before connecting the Bridgemate 1l USB server to your computer, the driver must be installed!

The server connects to your computer’s USB port using a USB cable. First: If the USB server driver was not
installed by the BCS installation program, run the BMinfSetup.msi program on the Bridgemate Flash Drive or
download it www.bridgemate.us/support.php?subpage=Download&subpageitem=USB Server Driver. Second:
Connect the server to your computer. Windows will install the driver — or it may display the New Hardware Found
Wizard.; in this case tell the system to search (browse) and automatically install the driver.

Power supply through USB port and batteries

The server will receive its power supply from your computer through the USB cable. If a USB hub is used, make
sure the hub is powered through an external power supply; otherwise the server may not receive enough or any
power to operate properly.

Batteries

Batteries are used in the event of power failure, for example when the computer is switched off. The Server battery
compartment holds four AA 1.5 volt batteries. Install the four batteries as indicated.

The server obtains its power from the PC through the USB connection. The batteries will only be activated if the
USB port is not supplying power (i.e., when the computer is switched off). If PC power is lost, the server immediately
transfers to the batteries and no data will be lost. We recommend installing batteries as a back-up while the server is
in operation. This will ensure no data is lost during the session. The batteries will operate approximately 50 hours.

Warning

Always install the batteries as indicated. Incorrectly installed batteries could damage the server and the batteries.
The batteries may start leaking, potentially damaging the server and voiding the warranty.

When removing batteries from the Bridgemate scoring device or server, do not use your fingers or finger nails to
remove the batteries. Instead use a blunt object like a screwdriver or pen to safely remove the batteries.
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Switching on / off

The server will automatically switch on once the server is connected to the USB port of your computer and the
computer is switched on. To switch off the server, the server must be disconnected from USB power (switch off
computer — or disconnect the server from the computer — and, if batteries are installed, press and hold the small push
button next to “Battery OFF” for a few seconds — until all LEDs are no longer lit.

Status indicators There should always be TWO green LEDs on the top of the server.

The server is equipped with a black
switch and 2 LED status indicators
labeled “USB / battery power” and
“Battery status.”

Center: Green confirms the server is running on USB power from the PC
Red confirms the server is operating on battery power
No light. There is no USB power or data in the server memory.

Lower light:  After connecting the server to a USB port:
Green = sufficient power left.
Orange = batteries are half full.
Red = batteries have less than 25% power left.
Blinking red = immediate battery replacement needed.
No light. No batteries or they are completely drained.

After a game has been completed and
the server disconnected from the PC
press — and hold — the switch to reset
the server which erases all the data
and turns off the battery power.

Automatic power-off

The server is equipped with an automatic power-off function. When the server runs on battery power, and there has
been no activity for a certain period of time, the server will automatically switch off. The default auto power-off time is
1 hour. This can be changed in Bridgemate Control Software in menu Tools > Settings > General.

Setting the region

When BCS is started with a new server attached to the PC, you will be asked to select the correct region. Select
North America. To enable the server to transmit data to the Bridgemates over the correct radio frequency, it is vital
that you select the appropriate region. The region setting in the Bridgemates is controlled by the Bridgemate
firmware. The Bridgemate firmware must be for the same region as selected for the server. In other words, the
server will be unable to transmit data to the Bridgemates if the server's region differs from the Bridgemates' region
firmware.

Setting the channel

The radio frequency channel over which the server communicates is set to 0 by default. For more information on
how to modify this channel, please see Chapter 4.

Configuring the Bridgemates

See chapter 5 on how to configure the Bridgemates and to put them in use.

Operating instructions

The Bridgemate |l server is very easy to use. Only a few instructions need to be followed. The following rules must
be observed:

Install the batteries as indicated. Incorrectly installed batteries could damage the server.

During use, make sure the server is placed horizontally on a level surface.

Do not place any objects on the server and make sure there is as much distance between the server and other
objects as possible. The fewer objects there are between the Bridgemates and the server, the better the data
exchange will be.

Where possible, make sure the Bridgemates and the server are not separated by a wall. The server should
preferably be placed in a central location between the Bridgemates. If this is not possible, place the server as closely
as possible to the Bridgemates along the edge of the playing room.

When removing batteries from the server (or Bridgemates) do not use your fingers or finger nails to remove the
batteries; use a blunt object such as a screwdriver or pen to safely remove the batteries. The edge of the battery
door often works very well; but take care not to damage it.
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Chapter 3: Bridgemate Control Software

The Bridgemate Control Software program is the bridge between your scoring program and the Bridgemate system.
BCS reads the session data from the scoring program though the results file and loads it into the server so that the
server can control the Bridgemates. Then, BCS retrieves the entered board results from the server and stores these
in the results file for posting by the scoring program. BCS has been designed for simplicity and ease of use and is
very user friendly.

This chapter contains information on the basic and advanced functions of BCS. For general program use, it is not
necessary to know all the information contained in this chapter. When first starting the system,be sure to read the

"o«

paragraphs “Launching Bridgemate Control”, “Logging in and logging off Bridgemates” and “Board results” first.

Launching Bridgemate Control Software

Bridgemate Control Software is launched from your scoring program. Depending on your scoring program, there are
several ways to launch BCS. The majority of scoring programs have a launching function, enabling fully automatic

activation of the Bridgemate server using the existing and active results file. For more information, please consult the
manual of your scoring program.

-

This BCS screen shows a 3 Section, mid-game condition
where all Bridgemates are active (except C1, C2, C3 & C5)
and game results have been entered for a number of boards.

The active results file name is displayed in the title bar. If no
results file is open, “No session active” will be displayed.

Server information

The pane in the top left-hand corner of the screen displays
information relating to the server. If a server has been found, g £
the text “connected” and the version number will be o
displayed. If the power adapter is used, the text “AC mains ==
adapter” will be displayed; if batteries are being used, the
power meter will display the number of operating hours
remaining as a percentage. If you are using batteries, we would recommend replacing them in time rather than
overusing them. BCS will indicate when to replace the batteries. Lastly, BCS will display the region and the channel
being used.

CORLUIEROHBTTOOBTOOD

Tables

The bottom left-hand corner of the screen lists the tables in play. In Club (single computer) mode only the “Client
tables” is visible. In Tournament (network) mode there are two tabs, All tables and Client tables. Below these tabs is
a list of tables. The All tables tab contains all the tables stored in the results file. These are generally all the tables
used in the session. The tables must be assigned to a client. The Client tables tab displays the tables assigned to
the client PC you are currently using. The name of this client is displayed in the bottom left-hand corner of the
screen. If you are using one PC for your sessions, all tables will be assigned to the same client. In this case, the All
tables and Client tables tabs contain the same tables. If you are using multiple clients (e.g., in big tournaments), the
All tables tab contains all tables in the session; the tables may be assigned to different clients. The Client tables tab
only displays those tables assigned to that specific client.

The scoring program will create the results file for you. Itis assumed that only one client is used. The program will
automatically assign all tables to the PC you are currently using. You do not need to perform any manual changes.
Manual changes are only required during big tournaments involving a network with multiple clients and servers.

Received board results

All board results read from the server are displayed in the right-hand side of the screen. For each hand/board
played, the table[s], pair numbers, declarer, contract, tricks made or set and the exact time the board result was
saved in the results file are displayed. BCS logs the time/date when the server was read and the board result was
saved in the results file. The system does not log the time/date when the hand was actually registered in the server.
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Board monitor and round monitor

To provide the director with up-to-date information on the progress of the session, a round and a board monitor are
available. The round monitor shows how many scores have been recorded for each table in each round. The board
monitor shows how many scores have been recorded at each board for each table. Both monitors are updated in
realtime when new results come in.

Result matrix
The result matrix shows the results conveniently arranged. A quick glance tells you which scores are recorded per
board or table. The matrix has different viewing orientations which can be controlled from the Options menu.

Players
This tab shows the member numbers as they are entered on the Bridgemates, and the names of the players — as
found in the local database (loaded from ACBLscore initially) or tournament database (pre loaded in BCS options.

Filtering and sorting board results
The multi-criteria filtering and sorting functions are in the bottom right-hand of the screen. This enables fast searches
for specific boards or to compare results using Section, Table, Round, Board, Pair NS and Pair EW filter/sort options.

Logging in and logging off Bridgemates

Logging in Bridgemate
After the corresponding tables have been added to the server, the Bridgemates can be activated.

Once the Bridgemate has been switched on, it will display the main screen with the Bridgemate Il logo. Press OK to
go to the section and table number screen. Depending on the setting of section and table number entry (see chapter
5), you may be asked to select your section and table number first. Press OK again to log the Bridgemate in to the
server. The flashing symbol in the top right-hand corner of the Bridgemate screen indicates that radio
communication is taking place. Once the Bridgemate has logged in, all first round data will be displayed. In the BCS
screen, the red symbol in the “Status” column of the table list will turn to green. This column also gives a clear
overview of all inactive Bridgemates: if the status column is still red, the table has not activated its Bridgemate.

In the following cases, the Bridgemate will not be logged in to the server, but instead the message “SYSTEM NOT
ACTIVATED YET” will be displayed and the Bridgemate is returned to the main screen:

The Bridgemate Scoring system has not been started yet by the scoring program.

The corresponding table has not been added to the server.

The server and the Bridgemate are not communicating over the same channel.

The region setting in BCS does not match the region setting of the Bridgemates.

The server is outside the range of the Bridgemate and cannot communicate with the Bridgemate.

Two other messages may be shown as an indication that the Bridgemate cannot start the session:

“TABLE STARTED BY ANOTHER BRIDGEMATE”

Another Bridgemate with the same section/table number setting has already logged in to the server. It is not possible
for two Bridgemates to log in with the same section/table number.

“END OF SESSION” The session of this table has finished, all scores have been registered for this table.

Logging off Bridgemate

The “End of session” message is displayed on Bridgemates that have completed all rounds and sent all the results.
These Bridgemates are returned to the “Bridgemate 11" main screen and are automatically logged off from the server.
The status column of this table will turn red again, indicating that the session has been completed on this table. A
clear overview is given of all the active tables. All Bridgemates with the green status display are still in use.

As well as logging off automatically at the end of the session, users are given three alternative options for logging off:
Using the reset function on the Bridgemate. The Bridgemate is returned to the start-up screen and is logged off from
the server. See chapter 5 for more information on how to reset the Bridgemates from the TD menu.

In BCS: via menu Server - Show tables, Reset table[s]. See chapter 4 “Overview of tables.”

In BCS: via menu Server > Show tables, Log off table[s]. See chapter 4 “Overview of tables.”

The latter function can be used if you need to use another Bridgemate for a specific reason but cannot log off via the
normal procedure. A Bridgemate needs to be logged off before it can be replaced. See also chapter 7.
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Board results

Reading from the server

Once the Bridgemates have logged in, they will feed data to the server during the session. These results are first
saved in the server. As long as the server is connected, BCS retrieves data every second from the server and
automatically stores it in the results file. This is an automatic process and indicated by the following message in the
status bar: “Status: retrieving data from server”.

If the server is disconnected for a while, all results not yet sent to BCS will be retrieved from the server, read and
saved in the results file as soon as the server is reconnected. Delayed reading and processing of scores is therefore
possible. It is advised, however, that the server is connected at all times during the session and BCS is running.

Viewing and filtering or sorting scores
Viewing scores

Results that have been read and saved in the results file are displayed in the right-hand table of BCS. Per result, an
overview is given of the corresponding table, the round, the team, the player declaring the game and the contract.
The registration time and date is also displayed in the results file. Remarks are also displayed (“Not played” = the
Bridgemate indicates that the game has not been played, 40%/60% = arbitral score entered in the Bridgemate).

Go to the menu Tools - Show/hide columns to select the columns you would like to show or hide.

Applying filter or sort order

As more board results are added and displayed, the more time-consuming and difficult it becomes to find or compare
specific scores. Although you will generally use your scoring program for this purpose, it is conceivable that you may
wish to view the registered data in BCS.

To display a specific section of board results, you can apply a filter to the entire list. This filter can be configured at
the bottom of the screen. Enter specific criteria per section, table, round and board number and NS/EW pair number.
It is possible to enter multiple criteria, for example section A, table 1, round 3. Per criterion, enter your filtering
preference - equal to, not equal, equal or less, equal or greater, between - and enter the relevant values. Select
Apply filter to apply the filter. To remove the filter and display all board results, press Reset filter.

The sort function can be used to sort the (filtered) results according to various criteria. Select the criteria and choose
Ascending or Descending for each criteria. Select Apply sort to start sorting the scores.

Round and Board Monitor

Use Round monitor to view the number of boards that have been reported from each table in play. This enables
Directors to identify slow players and visit the table, if necessary. Board monitor shows which boards have been
played at each table.

Result matrix

Another way of viewing the scores is the result matrix. The matrix shows the scores as a grid where the scores are
outlined for each table and board. This provides a quick way to locate/view a specific score.

The grid can be shown in four different formats:

Boards horizontally, tables vertically Use for Mitchell movements — Typically 7+ tables
Tables horizontally, boards vertically Use for Mitchell movements — Best for small games
Boards horizontally, declarer vertically Use for Howell or Mitchell where every pair # is unique
Declarer horizontally, boards vertically Use for Howell or Mitchell where every pair # is unique

Go to Tools > Options > General (tab) to select the desired method.

Creating Reports

Hand-record data from the right-hand display may be copied to an external file. For example, this can be used to
create a report that compares the results achieved by the various teams that played each board.

e Go to the menu Tools - Show/hide columns to select the columns to be in the report.
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e Select the records by highlighting the first entry for the report — hold the Shift key down and press End or use
the 1 or | key to select the desired records.

¢ Right click on the highlighted records and select “Copy scores to clipboard.”

o The comma-delimited data may then be “pasted” into an external program (such as Word and Excel).

Note: If the results file (i.e., 070904E.bws) is opened by a different client computer, the results will not be
immediately displayed in the right-hand panel. Follow the procedure shown under Managing tables, Taking over
tables from another client, on page 14.

Changing and deleting board records
You have the option of changing or deleting records saved in the results file and displayed in the result list.

Changing scores

Right-click on the record you would like to change and select Edit score. A detail screen will appear displaying all the
score data. You can now edit the result: Declarer is pair that played the hand; NS/EW is the “declarer” player;
contractis« =C, =D, v=H, =S, no trump = NT, double = x, redouble =xx, pass = PASS. Enter a space
between the value of the contract, the contract type and double/redouble. With “American Style” enter the numbers
of tricks taken — or number of tricks down.

If the board result has already been read by the scoring program, it makes little sense to change the board result in
BCS. It would be better in this instance to change it directly in the scoring program. If however the score has not yet
been read, this change can be performed in BCS and then it will be read into the scoring program correctly.

Note that any changes made to the results in the results file will be fed back to the server. Bridgemates will therefore
show the edited result in the overview of previous results.

If you wish to change a score from the result matrix, double click on the score to pop up the edit score window.

Deleting results

To delete a board result, right-click on the entry you would like to delete and select Delete score. To delete multiple
records simultaneously, highlight the first record - hold the Shift key down and use the 1 or | key to select the records
you would like to delete; alternatively, hold the left mouse key down and select records. The result will also be
deleted from the server. A new score can be entered in the Bridgemate.

Note: Deleted records will not be removed from ACBLscore if the result[s] were already posted into ACBLscore.

Scores cannot be deleted through the result matrix.

Processing scores in the scoring program

For information on how to read and process data from the Bridgemate results file, please consult Chapter 8: Using
Bridgemates with ACBLscore or the manual supplied with your scoring program.

Opening and closing results files

If no results files are open in BCS, options are limited. The Session menu is inactive and no server data can be
processed. During normal use of the Bridgemate Scoring System, the scoring program creates and automatically
reads the results file into BCS. You do not need to open the results file or read the relevant session data. This is
processed automatically. To read other results files in BCS, use the Open and Close functions in the File menu.

Opening existing results file

Use the File > Open menu to open an existing results file. If this results file has not been opened previously on this
client, BCS will ask whether the client wants to log in to this results file. This step is necessary to add tables to the
client and interact with the results file.

Closing the results file

Select File = Close to close the active results file. You can now open another results file.
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Using multiple clients

In ordinary club sessions all scoring is done of one computer. In large tournaments, however, it may be necessary to
split the session over multiple computers each serving a selection of the tables, while having the scores collected all
in one Bridgemate results file. BCS supports multiple clients simultaneously logging in to a single results file and
storing scores during the session from multiple Bridgemate servers.

In order to change the program to multiple client mode, go to menu Tools = Options - tab General, and set the
mode to “Tournament”.

The list of tables will now show two tabs: “All tables” and “Client tables”. The All tables tab contains all the tables
stored in the results file. These are generally all the tables used in the session. The Client tables tab displays the
tables assigned to the client PC you are currently using. The name of this client is displayed in the bottom left-hand
corner of the screen. The tables must be assigned to a client. If you are using one PC for your sessions, all tables
will be assigned to the same client. In this case, the All tables and Client tables tabs contain the same tables. If you
are using multiple clients, the All tables tab contains all tables in the session; the tables may be assigned to different
clients. The Client tables tab only displays (on both PCs) those tables assigned to that specific client.

The scoring program will create the results file for you. By default it is assumed that only one client is used. The
program will automatically assign all tables to the PC you are currently using. You do not need to perform any
manual changes. Manual changes are only required during big tournaments involving the use of multiple clients and
servers.

Adding a client to the results file

The results file keeps track of which clients are using the results file. Your scoring program will automatically add
your client to the results file.

If the results file has not previously been opened by the client PC (it was created on another PC), this client has not
yet logged in to and cannot use the results file. To add a new client to the results file, open the results file on the
relevant client. Confirm that the client is to be logged in to the results file. The results file may now be used.

Managing tables — Tournament (network) mode

Assigning tables to a client

Once a results file has been opened, all tables of the results file will be displayed. In Tournament (network) mode
the All tables “Client” column will display the currently-assigned Client, or “not assigned” if the table is not assigned to
any client. To assign a table to the client you are currently using, right-click on the table and select Add to client. To
add multiple tables simultaneously, select the table by clicking and holding the left mouse button and the Shift key, or
use the Select all function to select all the tables. Once the table has been added to the client, the client name will
be stored in the table. You can only assign tables to the client (PC) you are currently using. If you are using multiple
clients in a network, the results file will need to be opened manually per client and the tables added to that client.

Taking over tables from another client

To transfer a table that has already been assigned to another client to your own client, repeat the above procedure.
Right-click on the table and select Add to client. BCS will ask you to confirm whether you would like to take over the
table from another client.

Overview of tables assigned to a client

The client to which the tables have been assigned is displayed in the “Client” column of the All tables tab. The Client
tables tab only displays those tables assigned to the current client.

Removing tables from the client

Click on the Client tables tab for an overview of all the tables added to this client. Right-click on the table you would
like to remove and select Remove from client. The table will now be removed from the client.
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Server control

Activating the server

To activate the server, connect it to the client PC and connect the power adapter or fit batteries. Once the server has
been found, specific data will be displayed in the top left-hand corner of the BCS screen and the Server menu will be
activated. You are advised to connect the server before launching BCS.

Resetting the server
The server contains no data when initially connected to a power source. New tables can be added instantly.

If the server contains data which you would like to delete, you will need to empty the server. This is done using the
reset function. Go to Server - Reset. You will be asked to enter a verification number which is displayed on the
screen. This verification number ensures that the server cannot accidentally be reset. Once the correct verification
number has been entered, the server is emptied and all data removed.

Adding tables

The server is activated by adding tables. As soon as a table has been added, the server feeds this data to the
corresponding Bridgemate, which in turn is activated. The Bridgemate cannot operate if the corresponding table has
not been added to the server. Tables can only be added once to the server. If you attempt to add a table that has
already been added to the server, an error message will be displayed.

To add a table to the server, go to the Client tables tab, select the relevant tables, right-click on one of the tables and
select Add to server. The tables will now be added one by one to the server, and the corresponding movement
loaded per table. An overview of the added tables will be displayed.

Removing tables

It is also possible to remove tables from the server using the Client tables tab. Select the tables you would like to
remove, right-click on these tables and select Remove from server. The tables will now be removed. You will not be
able to use any Bridgemates that are configured to these tables.

Synchronizing the server and client e B
A” data relat|ng tO the tab|eS |S Saved Separately |n bOth the reSU|tS f||e and ¥ Delete tables from server which are not in session
the server. In the event of a temporary disconnect between the server and Tobles nservr uhch et clent
the PC, there can be discrepancies between the server and the results file. © o cons
These discrepancies can be rectified using the Session - Synchronize / g
recover menu function. e el D T
* Add to server
Check the relevant options to indicate your synchronization preferences. ® Gsliome
You must determine whether to synchronize the server to the results file, 8 : :
or whether to update the results file using the data stored in the server. Shorzs ] U Grdae et s v i

Tables in server which are not in client
Use this option to determine what to do with tables stored in the server but not assigned to the client. To delete

these tables from the server, select “Delete from server”. To add them to the client, select “Add to client”. Tables
that have already been assigned to another client can only be assigned to the current client if the “Take over from
other client” option has been checked. If this box has not been checked, the tables cannot be added to the client.

Tables in client which are not in server

Conversely, some tables may have been assigned to the client but not to the server. To add these tables to the
server, select the option “Add to server”. To delete these tables from the client, select the option “Delete from client”.
This option also allows you to delete all the tables from the results file by checking the “Delete from session” option.

Delete tables from server which are not in session

The synchronization function will also verify whether the server contains tables not contained in the results file.
These are so-called “obsolete tables”. Check the “Delete tables from server which are not in session” option to
delete these tables from the server. If this option is unchecked, these tables will not be removed.
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Synchronizing client to server and vice versa

As outlined above, the main function of the synchronization process is to synchronize the client to the server and vice
versa. The default settings of this function are configured to synchronize the client to the server: tables that have
been assigned to the server but not to the client are added to the client, and tables that have been assigned to the
client but not to the server are removed from the client.

These settings will need to be adjusted when synchronizing the server to the client. In this case, delete all tables
from the server that have been assigned to the server but not to the client (select “Delete from server”). Conversely,
add to the server all tables that have been assigned to the client but not to the server (select “Add to server”).

In all these cases, make sure the “Delete tables from server which are not in session” option is checked to delete all
tables that have been assigned to the server but not the results file (and therefore not to the session). Should it
transpire that these tables were correctly stored in the server and not in the results file, a new results file will need to
be created, or the current file updated.

Recovering the server

The Synchronize menu function also offers users the opportunity to fully synchronize the results file and the server.
To do this, go to the “Recovery” tab and press the “Recover server” button. All existing data will be deleted from the
server and overwritten with the tables and the data contained in the results file. The server is synchronized with the
current position of the results file. This function is ideal if the server loses its data and you wish to reconfigure the
server with data that has been recorded in the results file.

x|
— Select section:
Updating movement in the server o Sector & _Oese |

v Section B
Movement data is assigned to all tables added to the server during the
synchronization process. The synchronization function does not update
the movement data of tables already stored in the server and which have Hpdete maverent statting [+
not been updated. If the movement data of the results file has been

synchronized from the scoring program, and the scoring program does
not order BCS to update this data, use the Session - Update movement e
function to update the server with the correct movement for these tables.

All sections are checked by default. Uncheck all sections that you do not wish to update. By default, data is updated
from round 1. To update from a later round, select another round number using the selection option. Press Update
now to update the sections with the correct movement. Any table data belonging to sections that you wish to update
will now be deleted from the selected round onwards. A report will be displayed of the executed operations.

When updating from a later round option to “Erase results from prior h'grﬁc‘;toeumvement stating [Ea ]

rounds...” will appear. If this is checked, all Bridgemates will start from ' _ -

the selected round. However, this will erase all movement info of the - Ftase iesube fiom piio rounds and confinu Biidgemates
previous rounds and delete all scores from the server for those rounds.

Be very cautious with this functionality. If you only want to move the Updseron |

Bridgemates to the next round, use the “Close rounds” function.

Note: The scoring program normally updates all movements in BCS automatically. It is therefore not necessary to
invoke this function manually.

Close rounds

CIOSIng rounds  Select sections
If a Bridgemate hasn’t received all the scores of a round and it needs to be moved on the o
next round, for example due to late play or when players didn’t enter their score in the

Bridgemate, you can simply close the round in BCS and force all Bridgemates to move on

to the next round. Go to menu Session = Close rounds.

Cloze round 1 tox I 1 ~ I

Select the sections of which you want the Bridgemates to move on, and select the number
of round you wish to close. For example, if you want all Bridgemates of section B to move
on the 4" round, then select only section B by deselecting the other sections, set close
rounds 1 till 3 (not 4!), and press “Close rounds”. All missing scores up to round 3 for all
tables of section B will be filled up with Not played, and this will also appear in the result list and result matrix.
Bridgemates of section B which are still in round 3 will automatically move on to round 4.
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Program Settings (Options)
Change program functions using menu Tools -2 Options = General.

To disable the automatic server detection while the program is
running, check Disable server detection. You may wish to do this Mods Pragram seffings

when BCS is running without a server connected. During sessions, © b e 2 (e et el oo
however, you are always advised to leave this function unchecked. - Lewmament (netek)

al i Wiew ] Log flle] Scaring program]

W Erase oniginal records of deleted scores

[ Show Bridgemate options when starting ne

To close BCS automatically at the end of a session, check “Close

program at end of session.” This requires that all tables — at least B'idgemb‘ e
. . . . . . tecti

one time during the session — are logged in (all status indicators are Docs vt disable sorves detecion at statupl

green) and at end of the session all tables have finished and are

|Ogged Off Autopower-off period: 1 haur -

The Erase original records of deleted stores is required when using ACBLscore.

To view the Bridgemate settings before the Bridgemate system is actually started, check “Show Bridgemate options
when starting new session.” This allows the TD to verify if all settings are correct and make changes where needed
— before the movement is actually loaded into the server.

.
Tab View .
Ge ile locations | Scoring program |
When ACBLscore updates the movement, the result is shown on the Display Result s
BCS screen through a report window. You may disable this report. O e P
Note: the report will close itself after 60 seconds. e 7 el o
« . , . . . [Ameican sie = Py
American Style” should be displayed for North American operation. S fben
Shaw contract / score points:
Result matrix display options are discussed in Chapter 8. - e

f* Contracts and score points

Normally the Log files option will have the “BMPro.exe program folder” checked.
However, Windows VISTA and Windows 7 security precautions block writing to

General] Wiew  File locations l Scaring program]

Log files the log file in the default “C:\Program Files\Bridgemate Pro” folder.

" BMPro.exe program folder

& Other fome: ’ CAACBLSCOR When you are running Vista or Windows 7, the “Other folder” should be checked —

Select folder thenuse i uEEgkfalder i to specify a non-“Program Files” folder such as

C:\ACBLS . Double click on C:\ACBLSCOR to use as the log-file location.

BMPlayerDB.mdb databasze file

(" BMPra.exe program folder When using the ACBL National Tournament Database for player-name lookup,

" Other folder. cacBLsCORPLAYER  the same VISTA and Windows 7 security precautions block loading this file into

the Bridgemate Pro folder. Use “Select folder” to specify a different location.
C:\ACBLSCOR\PLAYER is suggested.

Also, when using a special location, the “seed” BMPlayerDB.mdb file must be copied into this C:\ACBLSCOR\PLAYER
folder from its initial C:\Program files\Bridgemate Pro [or C:\Program Files (x86)\Bridgemate Pro] folder .

Scoring Program and Player Database
]

General] Wigw ] Log file

ACBL affiliated Clubs/Units should select ACBLscore as the scoring program in
use; also, check the “Load player database after BMS command.” This works well
when your “local” (Club mode) database is not too large; i.e., perhaps no more Seoring program in use: ACBLscore
than 10 to 15,000 names.

Scoring program specific options

Club player names:

Should your ACBLscore program (and player database) be located in a drive other % Load player detabase after EMS command

than the C:\ “root directory,” click on “Change location” so that BCS can find the Bt (et A2 ERlLses ABess
database file when it is started from ACBLscore. m——r—

To use ACBL'’s very large “Tournament” data base, load the tournament database
into the special BMPlayerDB.mdb file. This action will take several minutes. Toumement player names:

Load tournament database |

For more information on using the “names” feature and options settings, visit www.bridgemate.us/User
Guides.php?subpage=Download&subpageitem=Names Display at Table



http://www.bridgemate.us/User%20Guides.php?subpage=Download&subpageitem=Names%20Display%20at%20Table
http://www.bridgemate.us/User%20Guides.php?subpage=Download&subpageitem=Names%20Display%20at%20Table
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Chapter 4. Server functions

Once the server is connected to the PC, the BCS Server menu is active. This menu contains several useful server
functions. It is not necessary to open a results file to use these functions.

Overview of tables

Use the Server - Show tables menu to create an overview of the x|

tableS Stored in the server. Total numbers of tables in server 15

Per table, the green or red status light indicates whether this table Secton | Tatle [~ Staus | __ Detetatiet) |

has logged in to the server, logged off, or has not yet logged in. ENMRREI S S— Lol oty _|

To delete a table from the server, select the relevant table[s] and A 5 : howscoss |

choose “Delete table[s]”. The tables will be deleted from the 4 =

server, as will all the recorded results of these tables. & B : Betieve scores |
. ®

To log off a table manually, select the relevant table[s] and click 5 G 2

“LOg Off tab|e[S]” g g : Update zettings |

B E

Click the “Show scores” button to create an overview of the scores B 7 d Resetablels) |

entered by the Bridgemate. Select the table[s] of which you would

like to see the board results and select this function.

Click the “Retrieve scores” button to move all entered scores for
the selected tables to the results file.

When the Bridgemate settings have been modified, they are updated in the Bridgemates by selecting the tables and
pressing “Update settings”.

To force a Bridgemate to reset itself, log off from the server and return to its main screen, select the table and click
“‘Reset table[s]”. Upon next communication with the server, the Bridgemate will reset itself.
Overview of entered scores

The Server > Show all scores menu function displays an overview of all board results entered in the server.
Depending on the number of tables stored in the server, there may be a delay in reading and displaying the data.

ate® Control Software

Restarting Bridgemate network

SERE Tocls  Help
w2 Show tables |
The wireless network can be restarted from the server using the function Server > Restart 2 show all scores
network. Use this function to solve wireless communication problems between multiple Show hand records

Bridgemates and the server. i Restart network
o Reset

Reqgion selection

Resetting the server Charel seleceor

The Server 2 Reset menu function resets the entire server and deletes all entered data. To avoid accidental resets,
you will be asked to enter a verification number which is displayed on the screen.

Note: If the server is not connected to the PC and/or is not fitted with batteries, all data will be lost. It is therefore not
necessary to reset the server before disconnecting it from the PC and pressing the “Battery Off” switch for 3 or 4
seconds.
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Setting the region

The Bridgemate Scoring System communicates over a
predetermined frequency spectrum. The permitted
frequencies differ per continent. Three continents are
currently supported: Europe, North America and Australia /
New Zealand. When first launching BCS with a new
server attached, you will be asked to select your region.
The server will select the corresponding frequency
spectrum to communicate with the Bridgemates. Typically
you should select “North America” and press “Set.”

Region selection
Regional settingz

Current regioh: Marth America

[ e regiom: | Marth America j

Europe
Morth Arnerica

Set

X]
Close

If you want to change the regional settings of the server, go to Server > Region selection.

Setting the channel

The server and the Bridgemates must be set to the same channel iR

to communicate with each other. To set the channel on the
server, use the Server - Channel selection menu.

The “Current channel” function displays the current channel.
Select the new channel and press “Set”. The new channel has

now been set.

System functions

Update firmware.

Channel settings
Current charinel: 1]

MHew channel: i ~

Set

(X

Cloze

The server’s firmware may be updated in the future. If there is an update, download the new firmware from
www.bridgemate.us/support.php?subpage=Download&subpageitem=Firmware and follow the instructions carefully.

USB Server Lights

"USB / battery power" LED:

e Green confirms the server is running on USB power from the PC.
e Red confirms the server is operating on battery power with game data in its memory.
¢ Nolight. There is no USB power and no data in the server memory.

"Battery status" LED: When server is connected to an active USB port - or there is game data in its memory:

e Green = sufficient power available.

Orange = batteries are half full.

Red = batteries have less than 25% power left.
Blinking red = immediate battery replacement needed.
No light. There are no batteries in the server, or they are completely drained.

Program Shutdown — Power Outages — Change PC

The following website page describes actions that may be taken to recover from these special conditions.:

www.bridgemate.us/resources/Manual/Program Shutdown-Power Outage-Change PC.pdf



http://www.bridgemate.us/support.php?subpage=Download&subpageitem=Firmware
http://www.bridgemate.us/resources/Manual/Program%20Shutdown-Power%20Outage-Change%20PC.pdf
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Chapter 5: Use of the Bridgemate® Il scoring devices

The Bridgemate is a small device designed to enhance the enjoyment of bridge for
tournament directors and bridge players alike. The system enables you to enter
scores faster than before, and is guaranteed to prevent operator errors. As well as
allowing players to enter board results, the Bridgemate also feeds information to the
players, such as the achieved percentage on the board played, and the traveler
overview. We are convinced that tournament directors and bridge players will
appreciate the convenience of the Bridgemate!

Preparing the Bridgemate for use

The Bridgemates are individually packed in compact sturdy cardboard boxes. Each
Bridgemate comes complete with two AA batteries, which must be inserted into the

bottom of the Bridgemate unit. The + and — signs in the casing indicate the insertion
direction of the batteries. Insert the batteries in the direction indicated, close the lid and
press the OK button. Check whether the “Bridgemate II” logo appears. The Bridgemate is
now ready for use.

SO

Exploring the Bridgemate
Large LCD screen for easy entry of scores, viewing results and other information.
Four function keys offering all kind of additional functionality.

Keypad with 25 large keys for easy input of scores and controlling the Bridgemate.

EEEEE
3 B3| R

FREEE
EEEFE
@«

The keyboard

The Bridgemate keyboard contains 29 keys. Some of the keys have a dual function.
Keys Explanation

These keys are used to enter numbers in the Bridgemate, for

1t0 9, 10 example board numbers, pair numbers, contract and result. The
10 button is used to enter 0 (when entering member numbers,
board numbers etc) and to indicate 10 as the lead card.

Ay Oy i € NP These keys enable you to indicate the contract & lead card.

+, - Indicates overtricks or downtricks of the result.

= Indicates that the contract has been exactly made.

J,0,K A Use these keys to specify Jack/Queen/King/Ace as the lead
card.

X, XX Double or redouble.

N/S, EIW Declarer’s direction of play.

PASS Indicates a pass-out.

CANCEL Correct an entry and cancel commands.

OK Confirm an entry.

Function keys 4 functions keys in the top row provide access to all kind of

additional functionality which is not covered by the 25 keys.
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Switching on/off

The Bridgemate does not have a separate on/off button. To switch on the Bridgemate, press the OK button. It is not
possible to switch off the Bridgemate manually. The Bridgemate will automatically switch off after it has been idle for
a while, i.e. no buttons have been pressed. No data will be lost when the Bridgemate switches off. Simply press the
OK button to continue as before. In other words, you can continue entering scores as soon as the Bridgemate has
been activated again.

The default autopower-off time is set to 20 seconds. This value can be changed to between 5 and 60 seconds. See
chapter 6 for more information.

Activating the Bridgemate -

When switching on the Bridgemate I for the first time, the main screen displays: [El'idQEITIE tE] ]:[
(version number and language may differ)

Presz=z 0Ok to start

.5

In the upper left corner there is a small battery indicator. Full batteries are indicated with a full indicator. If the
battery power is extremely low, the battery indicator will show an empty battery and the indicator starts blinking.
Although it is safe to continue using the Bridgemate for several more sessions, it is recommended that you replace
the batteries as soon as possible. The average battery life is approximately 400~500 sessions. However, this
depends largely on the length of each session, the time frame over which these sessions are played, and how the
Bridgemates are stored. Make sure no keys are pressed during storage.

Battery indicator

Configuring the Bridgemate
Before the Bridgemate is put into use the first time, it needs to be configured with the REGTON:  M-AMERICA
correct settings. Press the SETUP function key to access its internal settings menu. In T R
case the menu is proteced with a PIN code, enter one of the following fixed 3-digit PIN T N N BTN
codes: 749 or 769. SETUP wl4@ - PAGE /2

SETUP COD: OH

You can scroll through the menu using the up and down function keys. Use the + or —key  FUNTRAST: =%

to change a setting. Press the BACK function key to exit the setup menu. Any changes in
the settings will then be saved. T

Configuring the section and table

Before the Bridgemate can be used in the session, it needs to be configured with a section, table number. There are
three ways to set this information:
Fixed setting which the players cannot change
Flexible setting which can be changed before the session starts. (SELECT / SELECT mode)
Flexible setting with selection of available sections only (SCAN / SELECT mode)

SECTION: A
Fixed section and table setting TEELE: 1
A fixed section and table setting allows you to configure the Bridgemate for a specific table,
while not having the risk that this setting is changed by anyone. Once the setting is made, the Bridgemate must be
placed on the correct table that matches the setting. To do so, scroll the focus up or down to “Section”, and use the
+ and - key to adjust the section. Sections range from A to Z. Once the correct section has been set, scroll one
position down to table and use the number keys to set the correct table number. Press CANCEL to delete the
current number. Table numbers range from 1 to 511.

The Bridgemate will retain these settings until you next change the section and table number. In other words, these
settings will be retained even after the session has been completed. It is therefore not necessary to change the
settings for the next session. All you need to do now is move the Bridgemate to the correct table.

Flexible setting of section and table (SELECT / SELECT mode)

A flexible setting allows you to freely distribute the Bridgemates over the tables, and upon start of the session, the
Bridgemate will ask the players to confirm the section and table number of the table which they are sitting at. This
method allows you to assign numbers and

sections to tables at the very last minute while SECTION: A TRBLE: _ TABLE A2

the Bridgemates are already placed on the SELECT SECTION
table.

FPRESS OK TO START
WITH + OR - EMTER TRELE HUMEER
FRESS 0K TO COMFIRM PRESE 0K 1O COMFIEM  OF CANCEL TO CHANGE



22 Chapter 5: Use of Bridgemate Il Scoring Devices

In order to set the flexible setting, scroll the focus up or down to “Section” and press the + and - key until you see
“Select” behind “Section”. “Select” will also be placed behind “Table”. Press BACK function key to accept the
settings and return to the main screen. The Bridgemate is now configured for flexible entry of section and table
number at the start of the session. The Bridgemate can be freely placed on any table in the session.

Flexible setting with selection of available sections only (SCAN / SELECT mode)

This setting is very similar to flexible setting of section of table, but it limits the LIRIDWEE FHUE EELy
selection of section to the sections which have been uploaded to the server. A=1 B=2 C=3
Instead of allowing the player to choose a section ranging from A to Z, only the 0=4

sections which are used in the session can be selected.

In Setup, scroll to “Section”, and press the - key until “Scan” appears behind “Section”. Press the BACK function key
to exit the settings menu. The Bridgemate can be placed on any table in the session.

Setting Bridgemate region and channel

Use the up and down function keys to move to the “Region” row. Use the + and — keys select your region.

The Bridgemate |l scoring system can communicate over different radio channels. This enables users to install
multiple systems next to each other without causing interference (see also Chapter 6, “Multiple clubs”). To enable a
Bridgemate to communicate with the server, both must be set to the same region and channel. The default setting
for the Bridgemate and server channel is channel 0. To modify the channel, move to the “Channel”’ row. Erase any
exisiting channel number with the Cancel key and input the new channel number.

Language Select the language by pressing the + and - keys.
SETUP security code

To protect the setup menu from unauthorized access by players, set the “PIN code” to ON using the + or - key. The
preset codes are 749 and 769. Once the PIN code is set to On, the Bridgemate will ask for a PIN code.

Starting the session

THELE STARTED Occasionally another table will log on as the wrong table and players will see this screen. If this

EEIBEE%E happens, press OK to start the procedure to log on correctly with this Bridgemate — replacing
PROCEED AS A17 the unit that logged on incorrectly. Press ERASE to erase
CelL TO TO STeRT  This screen will appear. Enter the TD Pin code. When this is a:,leggezgﬁﬁhldaE'
85 TRELE Al encountered at the beginning of a game, press “Erase” to delete continue and retain
O PIN: _ everything entered by the errant table and enable the correct table previous data

to enter their player numbers and results. M
Switching on/off

To switch on the Bridgemate, press the OK button. The Bridgemate will automatically switch off after it has been idle
for a while, i.e., no buttons have been pressed. No data will be lost. Press the OK button again to continue.

Activating the Bridgemate and confirming Section and Table setting

At the start of the session, the Bridgemate will by default display the “Bridgemate 11" main screen. Press OK to view
the table and section settings of the Bridgemate. See Configuring the Bridgemate on page 22. Players choose their
section by pressing the number that corresponds with the section they will play in.

Entering member numbers (optional) ENTERSPUAYERS
If you have specified in BCS or your scoring program that you wish to enter member numbers g 35;;;33

the Bridgemate will ask you to enter the four player numbers. Use the number keys to enter | g. 789163

the number, and confirm by pressing the OK key. If a player does not know his member W:
number or does not have a member number, press OK without entering a number.

No number will be registered for this player.

Review player names

When the numbers have been entered, the next screen will display the names the BCS finds
for the entered numbers. If there is a correction to be made, press CANCEL to return to the
previous screen to correct any incorrect entries.

Joseph Steele
Henny Dorsman
Name N/A

Name N/A

PRESS OK TO ACCEPT
OR CANCEL TO CORRECT

SR




Chapter 5: Use of the Bridgemate® Il scoring devices 23

Enter results with the Bridgemates

Information before the start of the round

At the start of each new round, the Bridgemate will display the new round, direction of ROLMD 1
play and the expected pairs. The board numbers will also be displayed. For example, MEe 1 Ell: 12
you can verify at the start of the round whether you are seated in the correct direction and éDHHDS 1_;_1

have the correct boards on the table. This information is displayed as follows:

Press OK to confirm this screen and continue with the board input.
ROUMD 1 HE:l EW:lE 21-24

Entering board results EOARD : _
The following screen will be displayed when entering the board results: COMTR -
The information at the top of the screen shows the current round, the pair numbers and IﬁEgBLT
the boards to be played. The flashing line indicates the input position. W

Entry and verification of board number

Before starting to play the board, enter the board number and press OK to confirm. The Bridgemate will verify the
number. In case the board number is incorrect, or the board has already been played in that round, the Bridgemate
will notify so. It will also mention the boards that are yet to be played.

To assist the players entering the correct board number, two additional features are available which can be enabled
or disabled through the Bridgemate settings (see chapter 6):

Automatic entry of board number. When enabled, the Bridgemate will automatically fill in the next board number.
Assuming boards are played in order, this reduces the chance of entering a wrong board number.

Board order verification. When enabled, the Bridgemate will verify if the board number corresponds to the logical
order. If the Bridgemate expects a different board number to be entered, it will ask to confirm that the boards are
played out of sequence. If you do wish to play an out-of-sequence board, press OK. The Bridgemate will assume
that you have chosen to deviate from the logical order. If the board number was entered wrongly, press Cancel to
return to the previous screen and enter a new board number.

Once the board number has been entered and confirmed, the cursor will jump to the second line. You can now begin
the bidding. As soon as the contract has been determined, enter the contract and direction of the declarer.

Entry of contract and declarer

ROUMD 1 H::1l ER:l2 g1-24
To enter the contract, use numbers 1 to 7 and the %, ¢, v, A and NT keys. If required, EORRD = 21
you can also use the X and XX keys to indicate double or redouble. To specify the CONTE = GHT = M
declarer, use the N/S and E/W keys. If the declarer is North, press N/S once. If the LEAD
declarer is South, press this key twice. Alternatively, if the declarer is East or West, HESULT:
press E/W once or twice. The screen is displayed as follows: o ZCORE =]

Entering lead card (optional)
If you have specified in Bridgemate settings that lead cards must be entered, the Bridgemate will ask you to enter the
lead card. If not, this line will not be visible and the input position will jump to result instead.

Select the lead card using keys 2 to 9, 10, J, Q, K or A and the card type using %, ¢, ¥ or a. The card suit and card
denomination may be entered in any order.

Entering the result

Once you have finished playing the board, you can enter the result. Using “American Style,” when the contract has
been made enter the number of tricks taken. If the contract was not made, use the — key followed by the number of
tricks “down.” The = key may also be used when the contract has been exactly made.

Depending on the settings in BCS, the result can also be entered as the total number of tricks won (i.e., 0 to 13) or
Up/down tricks. When using Up/down, enter = key when contract has been exactly made, the + key followed by the
number of “overtricks,” or the — key followed by the number of tricks “down.”

Verification by East or West and confirmation of board result
After entering the contract, lead card (if requested) and result, press OK. “Verification by East or West” will display.
Pass the Bridgemate to East or West to verify the result and score points calculated by the

Bridgemate. Depending on the Bridgemate option, the score points will be displayed as EOF”{“B’ 15 “SZZBE”;f_lS‘G
assigned to the North/South pair or to the Declarer. ’ EW: 100
In a short while, the screen will automatically change and repeat all the information previously Press A%FEPT S

entered by North. The verification screen will for example be displayed as: cont r
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East (or West) verifies the data displayed on the verification screen. If this data is incorrect, E/W will press CANCEL
to edit the data. If the result is correct, E/W will press the ACCEPT function key to confirm the result. The message
“Entry completed” will now be displayed. The data is saved and sent to the server.

Overview of percentage achieved and previous results (optional)
After E/W has confirmed the board result, players have feedback options for viewing their achieved result and board
results achieved by other pairs. Depending on the Bridgemate settings, the following information can be displayed:

Achieved percentage for the entered board result ROUND 1 W51 EMil2  E1-ay
Overview of scores of other pairs on the entered board ENTRY COMPLETE
The percentages will be shown after the board result has been transmitted to the server. W= 2R% Ell: 79%
The server calculates the percentage by reviewing the other scores registered on the board,

the value of the entered score and how the entered score compares with the other scores. YIEW FESLLTST

This percentage will have little significance at the start of a session. As the session
progresses, percentages will approximate the actual end percentage.

Press OK to exit this screen. When the overview of scores of other pairs on the board is enabled, these scores are
now shown. Scores are shown as a frequency list, indicating the number of times the same result has been
recorded, i.e., 3x = 3 times. The first score is the highest N/S achieved score so far in the session on this board.

Depending on the setting in BCS, the scores can be shown in three different formats:

Zw M 4H f HEE0 3= M 4H & &80 2% H 4H g +580
1x 5 4H 5 B5H 1x +5 4H 5 +55H
o B2 90 e mdnd em ax Nane
o + o - ® = +
1 & 2&5-1 164 1+ & =2&-1 -1B8A
1:“: E EE—l +5[:] 2Hx H 4H-1 16A 2% H d4H-1 -1 @A
| " | e | | " | s | | " | e |

4 scores per screen. Own score bold. 6 scores per screen. Own score 2> 6 scores per screen. Own score 2>

Use the up and/or down function keys to move to the next or previous set of results.

End of round EHD OF REOUND 1

At the end of the round, the Bridgemate will display the message “End of round”. You do NS+ 1 El

not need to do anything. The Bridgemate will automatically switch off after a few seconds. Ell =+ STAYS

Press OK again to begin entering the scores in the next round. FRIETE T

Show Score Recap Automatically ~orE Feon  monros 21a

If the Tools > Options - Bridgemate - Bridgemate Il > “Show score recap automatically” 21:4H W 6 680

is checked, the results of the boards played at this table during this round will be displayed. 22:3NTxW 3 550
23:2C S -1 50

Show seatings for the next round 24:65x N 6 1210

At the end of the round, Bridgemate can guide the pairs to their next table[s]. This is shown

together with the end of round message. Seatings for next round information can be
enabled from the Bridgemate settings (see chapter 6).

End of session
At the end of the last round, the Bridgemate will display the message “End of session” and return to the Bridgemate I
main screen after a few seconds. The Bridgemate has completed its tasks and can now be safely stored away.

Special entries: Pass-out and board not played
If the players have passed four times without making any bid, enter ‘Pass’ at CONTR and confirm with OK. You will
not be asked for the lead card and the result; the Bridgemate will switch immediately to the verification screen.

If a board has not been played in a particular round, e.g., due to time constraints, the Bridgemate must be informed.
If this step is skipped, the Bridgemate will remain in the uncompleted round, and other pairs will be prevented from
entering their results. To enter an unplayed board, press the 10 key in the CONTR row. The screen will now display
the text "NO PLAY”. Confirm by pressing OK. The Bridgemate will now display the verification screen.

The Bridgemate will not display an overview for unplayed boards. As it is possible to play the board in a later round,
players must be prevented from seeing the results of previous boards. The board can be played afterwards without
the Bridgemate; in that case, the relevant score is entered manually into the scoring program.
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When rules in your club say that players are not allowed to skip a board without T E1-a4
notifying the director, the Bridgemate Settings (see chapter 6) should enable the option Conf irm MO PLH"!"
“No Play requires TD confirmation.” The Bridgemate will show the following screen: %F‘P?ﬁar‘d 21 with

The director enters his/her PIN code to confirm the no play. This prevents players
from entering a no play when they are not authorized to do so. ==A

General comments:

It is not necessary to enter the number of score points (+420, -50 etc.) in the Bridgemate. The Bridgemate will
calculate the score using the entered contract and result, taking vulnerability into account.

The Bridgemate monitors the active rounds. In case of a sit-out, the Bridgemate will skip this round.

Before starting a new round, verify whether you and your opponents are seated in the correct direction to avoid
playing in the wrong direction. At the start of the round, press OK to display the directions.

Fianking and game summary

Ranking and Game Summary Ranking

|Shc-w rarking at end of session only j

The Ranking feature (Chapter 6: Additional Bridgemate functions) must be
checked in order for the end-of-session results (shown as percent for each board —
or — match points won) to be available on the Bridgemates Il. Note, with the
ranking feature, information may be displayed after each round, or only at the end of the game.

END OF SESSION rankine arrer rovwn 9 | At the end of a game — or by logging back in on any Bridgemate as the
[Bridaemate) o . an RANKITRC | last table where you played — click on “Rank” to display the Provisional
9 EW: 6. 475 | Ranking; then click on either “Game Summary” button to display each

board played along with Match Points or Percentage. Press the E/W or
N/S button to switch between the information for E/W or N/S.

ReV|eW|ng scores and rectlfylng scores RBIJEEH:LD .Hs=1 Eki:12 BBy [ 1o
Reviewing scores entered CONTR - g%ng w g 68(5)50
After a board result has been entered and confirmed in the LERD - 23:2C XS i o0
Bridgemate, it may very well be that players still want to FESLLT: 24:6Sx N 6 1210
review what they just have entered. The Bridgemate allows mivaEm = CoRE=] ’

the players to review their own scores at any time during the round and at end of round.
To facilitate this function, the option “Score recap” in Bridgemate settings (Chapter 6) must be enabled first. Pressing
SCORES will show the score recap. Scores are shown from N/S perspective.

The entered board results including the score points are shown in order of board number. If more than four boards
are played in the round, up and down function keys are visible for navigating through the results. To exit the score
recap screen press the BACK function key.

Rectifying an input error

If you have made an input error while the board result has not been confirmed yet by E/W, press CANCEL to rectify
the error. In principle, it is possible to return to the board number input row by repeatedly pressing this button. Itis
also possible for E/W to reject the entered data by pressing CANCEL. The Bridgemate will now return to the input
screen, and the entered data can be deleted by pressing CANCEL again.

Once E/W has confirmed the score and the message “Entry completed” has been displayed, the score can only be
edited in the following two ways:

By the director through the special tournament director's menu (TD-menu). See the section “TD-menu” below.

By the players themselves through the score recap screen. When “Allow players to erase scores” is enabled by the
Bridgemate Settings (see Chapter 6), the score recap screen will show the CORREC function key. Press this
function key, and when asked for the board number to correct, enter the board number followed by OK. The result is
now erased and can be entered again by the players.
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Posting Bridgemate Il scores

Results to Bridgemate Control Software

Information entered on the Bridgemates is first saved on the server. The BCS program continuously reads the data
from the server and stores these in the results file.

Posting scores in the scoring program

Once the scores have been saved in the results file, your scoring program can post the scores. For more
information, please consult the manual of your scoring program.

TD menu

Tournament directors have far-reaching powers to verify and edit the entered scores and to award adjusted scores.
A special TD menu is available for this purpose. This menu is accessed with a 4 digit PIN code which must be set in
Bridgemate settings in BCS. The default PIN code is 0000. It is advised that the PIN code be modified before the
Bridgemates are brought into use. ESTIL E IO N 11 O 1 2

Activating the menu 1D PIN: _

To access the TD menu, press the TDMENU function key whenever it is visible. The
Bridgemate will ask for the TD PIN code. Enter the 4 digit PIN code. The TD-menu CEACE |

will now appear.

o TD-MENU v1.6.1 . o TD-MENU v1.6.1 : The TD-menu consists of two pages. Use the up and
A e 6. Score recap down function key to navigate between the two pages.
. View results 7. View hand record . .
D, TrrerD il 0. Reset To exit the menu, press the BACK function key.
g: ;::::ig boards T RS Gt To retransmit all results to the server, press the RESEND
ET—— |
Menu options
The TD-Menu has seven options:
1. Adjusted score To enter an arbitral (adjusted) score, press ‘1. Note: the cursor must be on Contr:
2. View results For an overview of the entered scores, press ‘2’.
3. Erase result To delete an entry, press ‘3’
4. Status If you would like to view the current table, section, round and pairs, press ‘4’
5. Missing boards To retrieve an overview of the board numbers not yet entered, press ‘5.
6. Score recap Display results already recorded in the Bridgemate. Useful when the “Scores” option is
not enabled for players to see the scores themselves.
0. Reset To reset the Bridgemate, press ‘0’.
-+ Adjust contrast To set the contrast of the screen, press + or -.

All options are available from both pages by pressing the corresponding key. There is no need to move to the page
which lists the options in order to use them.

TO-MEMU - ROJUSTED SCORE
Entering an arbitral score HE
It is possible to specify in the Bridgemate that an adjusted score must be entered Eld:
for a certain board. With the cursor is positioned at CONTR, access the TD-menu
by pressing the TDMENU function key, enter the PIN code, and once in the TD-
menu, press ‘1’. The following screen appears: | E:FICE |

Enter the arbitral score for both pairs. You can choose between 40% (average-minus), 50% (average) and 60%
(average-plus). Press 4 or — key to enter 40%, 5 or = key to enter 50%, 6 or + key to enter 60%. It is not possible to
enter a value other than these percentages. Press OK after you have entered both percentages. The Bridgemate
will now return to the result entry screen and the assigned arbitral score is now displayed at CONTR. Press OK to
confirm this, and confirm the verification screen. The Bridgemate has now saved an arbitral score for this board and
will feed this to the scoring program during posting.
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Retrieving overview

To obtain a overview of the results that have been entered on a specifc board on this table, use the view results
function of the TD menu. To access this overview, press ‘2’ in the TD-menu. You will be asked to enter the board
number. The overview displays the pair number, direction of play, contract and result. The number of score points is
not displayed in this overview. If the screen returns to the TD menu after the board number has been entered, no
results have been registered for this board at this table. Note that results that have been entered on the same board
but in other Bridgemates, will not be shown in this overview.

Erasing entry

Directors have always the option of erasing entries. This can either be a board result from the current round or any
previous round.

To erase a board input, press ‘3’ in the TD-menu. The screen will display the current Round: number and Board: If
the board to be erased is in the current round, just enter the board number and confirm with OK. If the board is from
a previous round press CANCEL to erase the current round number and then enter the round in which the board (to
be erased) was played. If that particular board can be erased, the message “Board erased” will be displayed to
indicate that the entered result has been erased. If the board has not yet been played, or not played on this table in
the current or previous round, the Bridgemate will return a message saying that no results could be found for that
board number.

Once a board result has been erased, the correct information may be entered.

Note when using the ACBLscore: Board results may be erased at the Bridgemate only if the result hasn’t already
been posted into ACBLscore. Once a board has been posted into ACBLscore, the correction must be made in
ACBLscore

Retrieving current status TO-MEMU - ETATUS
If you no longer know to which table and section the Bridgemate relates, you can Eablgf Tl
L =

retrieve this information in the status part of the TD menu. Press ‘4’ to retrieve Pairst 1-12
the status. The expected table and section of the Bridgemate will be displayed Eg;:g;: 212

first, followed by the current round, corresponding pairs at the table and the

boards to be played in this round. CEACE |

Overview of missing scores

From the TD menu, it is easy to establish which boards of the round have not yet been entered. Press ‘5’. The
Bridgemate will now display the numbers of the boards not yet entered in this round at this table.

Resetting the Bridgemate

The Bridgemate can be reset from the TD menu. Press ‘10’ and OK when prompted to confirm ‘Reset Bridgemate?’.
It will now return to the main screen.

Score Recap

The scores recorded in the Bridgemate for the current round may be viewed. This may be helpful to verify results
entered when the ability for players to see the scores themselves has been turned off in the Options settings.
Setting contrast

It is possible to set the contrast of the screen from the TD menu. Press + to make the screen darker, — to make the
screen lighter. Press the button several times to adjust the contrast. It is also possible to adjust the contrast if the
Bridgemate is in the Bridgemate Il main screen without using the TD-Menu.

Retransmitting all scores
Each score entered is stored in the Bridgemate’s internal memory. When one or more scores have been entered,

the TD-Menu will show the RESEND function key (above the NT button). This allows the TD to retransmit all scores
to the server. For more information about its usage, see Chapter 7, “Resending Results.”
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Bridgemate Control Software has a number of functions specifically designed for the Bridgemate Il scoring devices.

Optiens - Bridgemate E'
Bridgemate settings e
Use Bridgemate vettrgs spmctmd by .- Lco'mgoi:v:“l;lo 1e11ion sctive]
For Bridgemate settings use menu Tools - Options - Bridgemate O g |
V .‘lquﬂcyl:;:::! 2rcome cohnen =] A ay —

Settings specified by BCS or scoring program
Bridgemate settings can be specified either by the scoring program or BC3
For the scoring program to control Bridgemate settings, choose “Scori
program.” Check your program’s settings for Bridgemate options.
“Bridgemate Control” when you want to use BCS to control the
settings disregarding the information provided by the scoring program.

W Show gwe 1esull
Mugrmum seoui o shove. |Uninted =

¥ Skxom pescaniage of ove el Show contuacts ising

Group sections fosrevuky Symbo
Dehavions ¥ Chasctar
ect Shaw scers peints lom perspoctive of

Settings
Displaying previous results overview and percentage

To enable the Bridgemate to display an overview offrevious board results,
check the “Show previous results” option. To digglay your own score in this overview, check the “Show own result”
option. Your own score is indicated by a > en showing six scores per screen) or by bold characters (when
showing four scores per screen). Limit theAiumber of scores to be displayed by entering a maximum number.
“Unlimited” removes the limitation. Bogr@s may also be displayed as “Traveller” — one line for each result

To display the board result percentage achieved so far, check the “Show percentage of own result” box.

When multiple sections are calgdlated as one, check the option “Group sections for results.” The percentage will be
calculated across the field, arfd the results on all boards with the same number are shown in the previous results
overview. Especially in thi§ case, it is recommended to set a maximum number of scores you want the Bridgemate
to show. Without doing’so, the players will use up a greater amount of time watching the results at large sessions.

Results overview
Results can be shown in three different formats: See examples on Page 24. The ranking is: N/S best to worst.

Perspective of score points

Score points — on the East/West Verification screen — can be displayed from the perspective of the declarer or from
the N/S direction of play. In the latter case, E/W score points are shown as an opposite score (4H making 5 by E/W
is displayed as -450 or -650). This applies to the score points displayed in the verification screen for E/W and the
score recap. The overview of previous board results always shows the scores as 1 or 2 columns — N/S best to worst.

Entering results
Results can be entered in three ways: as overtricks / downtricks, as the total number of tricks won, or by using the

American style (tricks made/down). This should be set “American Style” for North American use with ACBLscore.

Displaying the pair number
If you do not wish to display the pair numbers in the round-information screen, disable the “Show pair numbers at
round info” function. This option can be used for team-of-four events.

Transmitting contracts

The Bridgemate offers users the option of feeding information to the server immediately after the contract and/or lead
card have been entered. This could for example be displayed on vugraph presentations while the game is still being
played. If you wish to feed this information to the server, check the “Intermediate transmission of contract” box.

Board order verification
Check the relevant box if you would like the Bridgemate to verify that the boards are played in the logical order. An
error message will appear on the Bridgemate if the entered board number is not in logical order.

Lead card
If you would like to enter the lead card on the Bridgemate, check this setting.

Member numbers

If you would like to enter the member numbers on the Bridgemate, check this setting. By default, players have the
option of leaving the entry blank when entering the member number. If entry of member numbers is compulsory,
check the “Blank entry not allowed” box.

Validate member number
If this option is checked, you may specify ACBL (North America) member numbers are to be validated.
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View contract
Use this function to specify whether the Bridgemate uses card symbols or letters for displaying the contracts.

Auto power-off periods

The Bridgemate will automatically go into auto power-off mode if it remains idle for a while. The default setting is 20
seconds. To change this setting, enter a value between 5 and 60 seconds in “Autopower-off period.” In “Verification
message,” enter the length of time you would like the message “Verification by East or West” to be displayed.

More Bridgemate settings (on Bridgemate Il tab) Pl I el &
Bridgemate : B
TD PIN code Set the 4-digit PIN code to access the TD-menu. Pt e st e
: . ® Mo enty PIN code: [0000
TD Conflrmatlon for NO Plav ;Ep:imal e””; I Mo play' requires TD confimation
Check the “No Play requires TD confirmation” box if players must — - —
Ca” the TD fOf' “NO play” approval. " Don't show names ¥ Remaining number of boards to be plaped
L. % Show names at each round v Mest seatings at end of round
ShOW rema”’“nq boards to be Dlaved " Show names at first round only ¥ Score recap
N . .. . Sellings ¥ Show score recap automatically
Enable this option to show the number of remaining boards in the —— ey —————
current round after E/W verification.. N © Stomate oty tbnd
. | Show ranking at end of session only || = Enable RESET function key
ShOW SeatInC]S fOI’ neXt round [ Show surnmary at end of session -
With the “Next seatings at end of round” option, the Bridgemate Oz #eEEE B el
shows which table pairs should go to and the direction to sit; to e | et
stay in their current position; or that they will have a bye. 7 Enler hand recards o end o raund r

Show score recap and allow score corrections

To allow the players to retrieve a score recap of their own scores entered in the current round without the TD’s
assistance, check the “Score recap” box. However, normally players are expected to call a Director when a score
needs to be corrected; thus, do not check the box “Allow players to erase scores.”

Show score recap automatically
When this option is checked, the Bridgemate will automatically display the scores for all boards played in the round
just completed at this table. It does not show the results of these boards at any other table.

Automatic entry of board number

If you want the Bridgemate to automatically fill in the board number and players only to confirm the number with OK,
enable this option. If board sharing takes place frequently and the order of boards played deviates from the logical
order, it is advised to disable this function.

Enable RESET function key

Pressing the TDMENU key will display RESET on Bridgemates Il for player access. At times, it can be helpful to
instruct players to reset their Bridgemate[s]. This does not cause any problem since the Bridgemate will
automatically return to the same screen when it is restarted.

Recording of bidding and play

Bridgemate has a built-in capability to record and bidding and play. This feature is generally only used at large,
international tournaments where live coverage of the game or full recording for statistical or review purposes is done.
Refer to the Bridgemate Developer's Guide for more information on this topic.

Pair number entry as part of declarer

The declarer on a board is normally indicated by direction only. As an additional verification of a possible pair arrow
switch (not uncommon in Howell games where pairs switch direction), the pair number may be entered as part of the
declarer. Players will be warned when the combination of pair number and direction input is not valid.

Link member numbers and names uzing source:

Showing player names

In order to promote correct seating of players, Bridgemates ¢ , , , ,
" Bridgemate gcore file. Requires that names are loaded in
player names at the start of the round By rewewm ames, players the: bwws file by the scoring pragran.

e ErPlaperDB.mdb lookup database file. Requires that
names are loaded in the lookup database file.

Configure name settings

Check “Show names at round” or “Show names at first round only.” ~ Noname source. Scofing program matches names with
Next - click “Settings” to configure which source BCS should use to find the member numbers entered on Bridgemate.

player names. Clubs/Units with a local player database will check the 1 ~ First Bridgemate score file, sscond BMPlayerDB.mdh
option; when using a Tournament database, check the 2™ opt|on TD’s that Iookup database file.

direct Club/Unit games as well as tournaments may check the 4" option; thus player names will automatically be
found in either the “local” database or the National TD file.
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Showing names using member numbers

Member number entry at the start of a session is mandatory in order to identify the players. Make sure that member
number entry is enabled (in the scoring program or Bridgemate options). BCS uses the member number to find the
player name. This requires that the correct source for the player names has been selected, either Bridgemate score
file, BMPlayerDB.mdb lookup database file, or “both” (4th option above) and that the source contains the names. If
the wrong source is selected, or the source doesn’t contain any names, BCS will not be able to find the player name.

Once BCS has found the player number, it will show the name and number in the “Players” tab, and show the name
on the Bridgemate. Special procedures are required in order to display the names of the pair with the first “sit out.”
See Chapter 8, Phantom-table sit-out pairs, for more information.

Changing names

In addition to the ability to make corrections on the Bridgemate (see “Review player names” on page 22), corrections
and additions can be made in BCS from the Players tab. Double-click in the “Name” column at a table/direction and
enter or modify a name; the new name will automatically display on the Bridgemates Il. Alternatively, double-click on
the member number and provide a new or correct number. BCS will display the name for the new/corrected number.

Hand Records

ENTER HAND RECORD ENTER HAND RECORD ENTER HAND RECORD-BOARD 7
Boards that have been shuffled and dealt at the table may be eNTER Board: ao novsrs | S, ames
recorded by the players. Hand records are entered on the HAND RECORD? -8 > oya2.
Bridgemate — at the end of a round. It is not compulsory, so BACK o9
slow playing tables can move on to the next round; subsequent table(s) can enter the hands. B s rer

North, East and South cards are entered; the remaining cards will automatically display for West.

=E Shiow Eables
If the “View hand records” option is checked, players may view a hand on their Bridgemate after g Show all scores
playing the board. The Director may use the TD MENU (from any Bridgemate) to display any@d/ﬁhEIW hand records
record — regardless of the “View” option setting. Also, hand records may be viewed in BCS. $  Restart network

Use File > Export to export hand records a .pbn or .dup file. A .dup file is good
for displaying hand records on a website; also, it may be imported into
Dealmaster Pro to calculate makeable contracts for more website detail.

‘5’ Bridgemate® Control Sofi it Reset

Session  Serwer Tools  Help by

Vs Region selection
Conne .
Bricoe Channel selection

Save as Ch+S

Update settings during play

Option settings are sent to the Bridgemates when a new session is started and Bridgemates log in to the server. lItis
also possible to modify the Bridgemate 1l settings during play and have the Bridgemates use these new settings.

To update the Bridgemate |l settings after the Bridgemates have already started the session, do the following:
1. Update the Bridgemate settings either through the Bridgemate and Bridgemate Il settings tabs in BCS (Tools
-> Options) or in ACBLscore.
2. Go to menu Server - Show Tables.
3. Select the tables you wish to update the settings for. Note, CTRL + A will select all the tables at once.
4. Press the “Update settings” button. All Bridgemates Il will now receive the modified settings. Upon its next
contact with the server, the unit’s settings will be updated.

Updating Bridgemate firmware

The Bridgemate is controlled by a piece of software in its internal memory. This software can be changed from BCS.
In concrete terms; this means that the Bridgemate can be updated and functions changed/added. In other words,
each Bridgemate can be updated without requiring the purchase of new Bridgemates.

Preparing the Bridgemates:

Collect all the Bridgemates you want to update.

Make sure they are set to the same region and channel as the server.

Make sure they show the main screen with the Bridgemate logo.

Bridgemates should have enough battery power; the battery indicator should not blink.

Preparing the computer:

Connect the server to your computer and the mains power.

Start BCS without an active session. BCS can be started from the Windows Start > All Programs menu.
Make sure the Region and Channel settings of the server match those of the Bridgemates.
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Starting the firmware broadcast:

In BCS, go to menu Tools - Bridgemate - Bridgemate Il update firmware.

Click “Select firmware file”.

Browse to the desired .bom2 firmware file and click “Open” to open the file.

In case different versions are available in the firmware file, select the desired version. Otherwise, if there is only one
version available, this version will be automatically selected.

Click “Upload firmware” to upload the firmware to the server. This may take a while to complete.

Make sure “Continuous transmit” is checked and press “Transmit firmware”. Press OK to confirm.

The firmware is now continuously being broadcast by the server. A progress bar shows the ongoing status of the
server’s broadcast — starting again after reaching 100%. This will continue until the “Stop transmission” button is
pressed, or after the firmware has been broadcast twenty times.

Receiving the firmware by the Bridgemates:

Press OK on the Bridgemate to awaken the device.

Press SETUP to enter the setup screen; if needed, enter pin code 749.

Press INFO to enter the version info screen.

Press UPDATE to enter the firmware update mode, and press OK to start the receive mode.

Provided that the firmware broadcast has been started in BCS, the Bridgemates will start receiving the firmware. A
progress bar on the Bridgemate indicates how much of the firmware has been received. When the firmware is
received completely, the Bridgemate will return to the main screen.

After all Bridgemates have updated, press “Stop transmission” to stop broadcasting; close the update window.

Remarks:
Do not abort the transmission before all Bridgemates that are receiving the firmware update have finished.

If firmware transmission is interrupted, Bridgemates remain in firmware update mode until the firmware is again
broadcasted and received fully by the Bridgemate.

The transmission progress bars in BCS and on the Bridgemate do not necessarily progress equally.

When the progress bar on a Bridgemate reaches 100%, it will take a few more seconds to complete.

Firmware update can be activated at any time. Bridgemates will automatically start receiving the firmware, even
when the transmission has started earlier. Bridgemates do not have to be in the firmware update mode before
firmware transmission is started.

o Bridgemate®

N Session Serv

e Bridgemate® Control Software -

Server  Tools Help

Saving the .bws (results) file

The File > Save as function may be used to
save the .bws file to a flash drive for later use.

>y Saveas ChH4s
Close

Edit: moverment

aynchronize | recover
Update mowvement
Close rounds

Firrn Upload hand records

Expork

Fit

Real-time Publication

During a game the rankings may be continuously displayed. The display will start after N
a few seconds (by opening your browser — Internet Explorer, Firefox, etc.). As each new score is received, the
display will automatically update to show the latest rankings. The display options are. Report Session

Fun Bridgemate Pro concurrently

Report Session

v Enable Live Ranking

[v Show number of boards

[v Show percentages
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TABLE STARTED
BY ANOTHER
BRIDGEMATE

CALL TD TO
START

AS TABLE Al
TD PIN: _

PROCEED AS Al1?

Bridgemate logged on as the wrong table

When a Bridgemate logs on under a wrong section or table number, this will have its effect on
the Bridgemate of the other table whose section and table number has now been occupied.

Press ERASE to erase
all previous data.
Press CONTIN. To
continue and retain
previous data

To rectify this situation, the Bridgemate Il has a simple “take over table” procedure. Just let
the Bridgemate of the correct section/table start the session. It will show that the table was
already started by another Bridgemate and asks to proceed or to cancel. Press OK to
proceed, and call the TD to confirm the take-over using the TD PIN code. The TD should
press the “Erase” button to remove the player numbers and any scores entered by the errant table. The correct table
may now enter their player numbers and start playing. After confirmation, the table will start the session.

The wrongly-logged-on table will now see a message that another table has taken over. They may
now log on as their correct table, enter their player numbers and any results.

ANOTHER
BRIDGEMATE HAS
TAKEN OVER

Replacing Bridgemate

If for whatever reason you need to replace a Bridgemate during a session, and you are unable to log off the
Bridgemate using its reset function, proceed as follows:
¢ Remove the Bridgemate to be replaced.
o Take another Bridgemate and set it to the Section/table where you wish to place it in service.
¢ It will inform you that the table has been started by another Bridgemate: Press OK to proceed, enter the TD
PIN code, press CONTIN. This Bridgemate has now replaced the unit that was “taken out of service.”

Alternatively:

In BCS, go to menu Server - Show tables.

Select the relevant table and press “Log off table[s]”. The Bridgemate will now be logged off from the server.

Take another Bridgemate and set this Bridgemate to the correct section and table number. Also make sure to set the
correct channel.

Activate this Bridgemate. The Bridgemate will take over the position of the old Bridgemate.

Recovering the server

If the server is accidentally disconnected from the PC — and there is no battery power — all data will be lost and the
Bridgemates will stop functioning. Bridgemates will typically display “FAILED TO SEND, RETRY?” BCS,however, is
able to recover the old situation. Proceed as follows:

Make sure the server is reconnected the PC and that BCS shows the server is “Connected.”

In BCS, go to menu Session = Synchronize / recover.

Go to the “Recovery” tab and press “Recover server” and follow the screen prompts — including entering the 3-digit
number (when prompted). All information from the results file will now be moved to the server.

When recovering the server, it is important that all data had already been read from the server into the results file. If
this is not the case, information that had not been recorded so far will not be recovered back
into the server.

It should also be noted that results may resent to the server.
During a game: After a game has finished
On the TD-MENU page and before the next game is started, go
press the RESEND key to SETUP - INFO press the RESEND key

TD-MENU v1.6.1
. Adjusted score
View results
. Erase result
. Status
. Missing boards

BACK v RESEND

HARDWARE: 1.0
FIRMWARE: 1.6.1
PROD.DATE: 2009-1

U WN P

B

BACK UPDATE RESENT

Procedure in the event of data loss

The security of the board results entered in the Bridgemate Il scoring system is given top priority. The best defense
against data loss is to store the results in multiple locations, namely:

The Bridgemate memory

All results entered in the Bridgemate are sent to the server. At the same time, each result is also stored in the
Bridgemate’s internal memory. These results are stored until the Bridgemate is started up again for a new session.
Then the memory will be erased.

The data remains stored in the Bridgemate, even if no batteries are installed. See the instructions above on
resending results from the Bridgemate’s memory to the server where they may be recovered by the BCS.
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The server memory

Results entered in the Bridgemate are sent to the server, and stored in the server’s internal memory. It is essential
that the have batteries installed — so it can switch to battery power if the PC power is lost. If there is no power
source all data will be lost.

BCS results file and log file

BCS continuously reads the new results from the server and processes these into the results file. This data is
immediately written to the hard disk of your PC, ensuring the data is safe — even in the event of power failure. All
results shown on the BCS screen have been written to the results file.

BCS also has a log file, containing all the relevant events. All received results are written to this log file. To view the
log file, go to the Tools = Show log file menu. The actual file — BMProLog.log — is located in the folder specified
under the Tools - Options - General - View Tab.

Special Note for Vista and Windows 7 Users: See Log file settings, Chapter 3, for specific details.

Session file in your scoring program

Lastly, the scoring program retrieves the results from the results file and stores the results in its own files.

The results are therefore stored in five locations in total. In the event of data loss in one of the five locations, it is
possible to check whether the results are still stored at the next level up, and to reprocess the results from there.

Scoring program data loss

In the event of data loss in the scoring program, check whether the results are still stored in the BCS results file. The
recommended method is to launch BCS from the Windows Start - All Programs - Bridgemate Pro - BCS. Once
BCS is started, go to the File = Open menu and select the results file for the session. If the results appear on the
screen, they have been stored in the results file. The results can now be reprocessed from the scoring program.

BCS data loss

If the results file contains no results (see the above-mentioned step), it is possible to retrieve them from the server
and to read them in the results file. The first step is to check whether the results are still stored on the server. Use
the Server > Show all scores menu for this purpose. All the results stored in the server will now be shown. If the
correct results are shown, it is possible to read them manually using the Server > Show tables menu. Select all
tables (Ctl-A is a shortcut to select all the tables) and press “Retrieve scores”. The results of the selected tables are
retrieved from the server and processed in the results file. The results can now be read by the scoring program.

Server data loss

If neither the server, nor the results file, nor the scoring program contains any data, your last resort is to retrieve the
results from the Bridgemates. All results entered in the Bridgemate are stored in the internal memory of the
Bridgemateand can be resent to the server. See the section above entitled “Rcovering the Server.”

Warning
The board results are stored in the internal memory of the Bridgemate. Once the Bridgemate has been started up

again for a new session, the memory is erased and all the data removed. This procedure is executed after you have
pressed OK in the SECTION/TABLE screen and the Bridgemate has logged into the server. Ensure that no players
are operating the Bridgemates to avoid the Bridgemate logging into the server.

Retrieving results from the log file

Results can also be retrieved from the log file. All results entered in BCS are stored in the log file. To view the log
file, go to the Tools = Show log file menu. The selected rows can be copied and saved to an empty text file and
printed. Automatic processing is not possible; the results must be entered manually in the scoring program. The
actual file, BMProLog.log, is located in the BCS folder, normally C:\Program files\Bridgemate Pro.

Special Note for Vista and Windows 7 Users: Because of Windows’ “security precautions,” use the BCS option to
specify a non-Program Files folder where the Log File should be saved. See Lod file settings, Chapter 3, for details.

Resending results

The Bridgemate retains the board results in its internal memory. With a simple command these results can be resent
to the server. This is useful when results have been erased from both the computer and server inadvertently and
your last resort is the Bridgemate device itself.

Results can be resent from both the TD-menu and the setup menu. Proceed as follows:
1. Make sure the server is connected and loaded with the session data (tables, movements). When all data in
the server was lost as well, restart BCS from ACBLscore in order to load the session data back in the server.
2. a) Bridgemates which are still in result entry mode can resend the results from the TD-menu. Access the
TD-menu with the TDMENU function key and PIN code, and press RESEND function key.
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b) Bridgemates which show the main screen can resend the results from the setup menu. Press SETUP and

the 749 or 769 Setup code for the Setup menu; press INFO function key, followed by RESEND function key.
3. The number of board results in the Bridgemate memory is displayed. Press OK to start the retransmission.

Retransmission will only succeed when the server is activated and contains the session data.

After retransmission, the board results can be posted in the scoring program using the normal procedures.

Multiple bridge clubs playing simultaneously

There may be times when 2 or more bridge clubs are playing at the same time in one building — each with their own
client PC. As the Bridgemate server can accommodate only one specific client computer at a time, it is not possible
for two clubs to make use of one server simultaneously. Both bridge clubs will, therefore, require their own server.

It is of course vitally important that they do not interfere with each other. This problem can be rectified by:
e each club using different Section letters. In this case the clubs can use the same channel.
¢ the systems communicating over different channels. The first club sets its system (server and Bridgemates)
to channel 0, while the other uses channel 1. A third and fourth club can then use channel 2, 3, etc. This
method enables multiple clubs to use the Bridgemate scoring system in the same area simultaneously with
the same Section letters without causing any interference.

Large tournaments

During large tournaments, more than one server will be required to control over 256 tables. The layout of the tables
is important in this respect. If the tables are outside the range of the server, an extra server will be needed to
increase the range. The Bridgemate Scoring System supports multiple servers over a network. In principle, this
network can support an unlimited number of tables. The following guidelines must be observed:

- You will need a fully operational network in which all used PCs are interconnected, enabling them to access
and process files.

- Only one results file is used, containing all session data and board results of all tables.

- The scoring program is running on one of the computers in the network. It is not necessary for the scoring
program to be running and/or the results file to be stored on one of the client computers that is running BCS.
From an organizational point of view, it may be easier to use a separate PC containing the scoring program
and results file. Client PCs access the results file over the network.

- Each Bridgemate server is connected to its own PC (=client) where BCS is running. Do not connect two
servers to one client; although technically feasible, it may cause unnecessary confusion, as both servers are
using the same client name. Worse still, it may even be counter-productive if both servers are operating
over the same channel.

- Use different channels for each server, especially if the servers are within range of each other. Only use the
same channel if you are sure that the servers are not interfering with each other (e.g., in different buildings).

Using ACBLscore and Bridgemates on a Network

ACBLscore and the Bridgemate Scoring System can be used on a network where the ACBLscore program and
Bridgemate Control Software (BCS) software both operate on one computer. Each separate client computer will run
its own BCS program and open the single results file, e.g., 070904E.bws, on the ACBLscore computer.

ACBLscore Computer
Configure the C:\ACBLSCOR\GAMEFILE folder for Network sharing and “change my files” by a remote computer.
In BCS, Server &> Show Tables, highlight tables controlled on the remote computer[s] and click Delete Table[s].

Remote Computer[s]

Open BCS program and manually open the *.bws file on the ACBLscore computer.

Under “All Tables” — highlight tables to add to this client — right click and click Add to client
Under “Client Tables” — highlight tables to add to this client — right click and click Add to server

If the Bridgemates working into the Remote Computer[s]’ server[s] are configured for different channels, the BCS
changes need only be made at the Remote Computer(s].

Contact Bridgemate.US for more detail.
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Chapter 8. Using Bridgemates Il with ACBLscore

ACBLscore (Windows), starting with version 7.45, supports the Bridgemate Scoring System. This chapter describes
how to use ACBLscore to activate Bridgemate Control Software (BCS) and retrieve information from the results file.

Installation

Software Required
o ACBLscore (Windows version) v7.71 or later — download from www.acbl.org
¢ Bridgemate Control Software install program — on website www.bridgemate.us/support.php or Flash Drive.

Install software

The BCS program controls communication with the Bridgemate Il hardware and exchanging data with ACBLscore
through the results file. The default installation folder is C:\Program Files\Bridgemate Pro. If BCS is installed in
another folder, you will need to identify the “different” installation folder to ACBLscore.

e BCSsetup.exe installs BCS and the USB driver. It is recommended you accept the default installation folder.
Special Note for Vista and Windows 7 Users: Because of Windows’ “security precautions,” use the BCS
option to specify a non-Program Files folder where the Log File should be saved.

See Log file settings on Page 17, Chapter 3, for specific details
¢ Install ACBLscore Version 7.71 or later.

Note: Normally, BCS and ACBLscore will be installed on the same “client” PC.

Connect the Bridgemate Server to the Computer.

The server uses a standard USB cable. Windows should recognize the new device and provide screens to install the
driver. The Server receives power from your computer’'s USB port. The 4 AA batteries should always be installed
to provide “backup” power if there is any PC power problem. This will preclude inadvertent loss of scoring data.

B CS Setu p yaf Bridgemate® Control Software -
File Session Server Tools Help

Verify BCS/server connectivity T
System Bridgemate ||

Once the server has been activated, start BCS to see if it finds the server. Normally, BCS is e N

started by ACBLscore; but to verify server connectivity, it is recommended BCS be started Eonmricaon voson 11

directly from the Windows start menu at this time. [Go to Start - All programs > Bridgemate it 5

Pro = Bridgemate Control.] A small text bar will display while it searches for the server. Fea et ee

The BCS screen should show “Connected” in the upper left “Server Information” section.

Verify that the region is set to North America.

58"'5'5|] wigw | Lo fils | Scoring program |

Set BCS options Optional
. Mode P settings

GO tO menu TOOIS 9 OptlonS 9 General & Club [single computer] v Close program at end of session
“C|Ub (S|ng|e com puter)” £ Toumament [network] Iv Erase original records of deleted scares
“Disable server detection” (unchecked) I Show Bridgemate aptions when starting ne
“Erase original records of deleted scores” MUST be checked when using”dgAangaltgalﬁascore

H 1 H [~ Disabl detect]

See_ Chapter 3, Program S_ettlnqs (O_ptlons), page 17 for option Bt e e st 8 )

settings on the General, View, Log file and Scoring program tabs.

Go to Tools = Options > Bridgemate S =i

Options should be set as appropriate. See the laminated
Quick Setup Guide and Chapter 6, Bridgemate settings, page 28.

Configure Bridgemates
1. Use SETUP to configure each Bridgemate.

2. Each Bridgemate may be:
- assigned to its own Section and Table: A1, A2, A3 ..... ,B1,B2 ...., etc.
- configured for manual entry of the Section/Table by players at the table when a new session is started,


http://www.acbl.org/
http://www.bridgemate.us/support.php
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- set to scan for available Sections. For example: A=1 D=2 (Enter 1 for Section A or 2 for Section D)
See Chapter 5, page 21 — Activating the Bridgemate.

3. The default RF (radio frequency) channel is 0. If you experience transmission troubles with this channel,
change to another channel. The channel selected in BCS for the Server must always be the same as the
one set in all the Bridgemates. The frequency range for North America is 902 ~ 927 mHz.

Note: Bridgemates automatically shut off power when not in use. Batteries need not be removed when not in use.

In the upper left corner of the Bridgemate Il screen there is a small battery indicator. Full batteries are
indicated with a full indicator. If the battery power is extremely low, the battery indicator will show an empty
battery and the indicator starts blinking. Although it is safe to continue using the Bridgemate for several
more sessions, it is recommended that the batteries be replaced as soon as possible.

The average battery life is approximately 400~500 sessions. However, this depends largely on the length of
each session, the time frame over which these sessions are played, and how the Bridgemates are stored.
Make sure no keys are pressed during storage.

The Bridgemate Scoring System is now ready to be used with ACBLscore.

ACBLscore Setup

? Help/New diUtilities @
E# Set Path
5 set Printer

When the background screen is green, the program is in Club Mode Bl 3et sgreen Font
and Game Options will be visible. If the screen is pink and/or Game ~ BZeurnanent/clus node

dit of Names in Game File

. - . . . Gal Options O [«F
Options is not visible, switch to Club Mode (from Tournament mode). =~ W aLiow auro srraciricacion

rsion W7.49 08/13/2007 Copyright (c) 1991, #] AL1aw Remote score entry

Enable Bridgemate functionality

Go to: Setup > Game Options It is recommended that all 3 options be selected.

Set Bridgemate Options in ACBLscore

It is recommended that Bridgemate options be configured in BCS for control by the scoring program — ACBLscore.
Once the Bridgemate options have been set, they will be used for all future games — until changed.

When a game is first “opened,” press F11 to display the Typical club game options are shown here
“Select Command” screen. Left click on “BMO Remote Options” e —————
or highlight the line and press ENTER. o {Allow ety of player Tumbers st Temoi

708 {A) - F11 or AL for Command list oA o Add 5 secion
Mow File. No Sections deSned CLUB mode

Frinnes. Ganesic Namow

AWSCORE Varsion VW7 £ (51372007 Copyr 207 ACEL

Set up a Game

1. With the BCS program already in-
stalled, create the game file and set
up sections in the normal manner.

Special considerations are:

Pick-ups should be: “Sequence by table number”

Select posting method

2 Fick-ups - Sequence by N-S pair number
3 Trawvelers - Sequence by N-5 pair nurmber

Every player must enter a player number
= Auto Strat when posting names from remote
# Show previous results of the board just played
Maximum results to show (0-127, 0 = unlimited) 0
= Show your own result in the list of previous results
 Enable the possibility to repeat the results
# Show the percentage on the board just played
# On = Show score from perspective of declarer, Off = N-5
“ Show pair numbers in the round info screen
= Verify the board number on correct order of entry
% On = North American results entry method. Off = European
= On = Show contract as letters, Off = symbols
Remote auto power off time {5‘60}' 20
Verification message display time (1-7) 1
Press F9 when done

QK Cancel

Press ENTER for No

Use Remate Server for score entry

No Cancel

Click “Yes” or use cursor key to highlight “Yes” and press ENTER to "Use Remote Server for score entry”

2. ACBLscore automatically interrupts “posting” as of the penultimate (next-to-last) round to accommodate
preparing a one-round-to-go report. After all results for the next-to-the-last round have been posted, one or
more additional ACBLscore “post” commands will be needed to complete a game.
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3.

4.

To set up a new game (especially with multiple sections) in ACBLscpfe more gy_itﬂ:klﬁy_,vyg_q“may‘pypgssq event

rating. See Quick Setup Tips on page 38. EMP  Postscores from Remols
. BMS Start Remote server - reset server - beginning of session
When all Sections are set up, start BCS software. BVA Rostar Romofe seror - do NOT resetcarver
. “« » acate Remaote server
The Bridgemate commands are at the “end/bottom” of the BMN  Postnames from Remate
F11 commands; scroll down, or press the End key. Ll e LA :
Lancel Help

The BMO command is used to set Bridgemate options, when
BCS software is configured to use options settings specified by the “Scoring Program.”

The BMS command is only used to start a new game/session. This will RESET the BCS software, server
and Bridgemates — erasing any existing settings.

The BMR command is used to “restart” BCS without losing data already entered. This may happen when
the PC has been stopped, e.g., due to a power failure, PC reboot, or any other reason for BCS being shut
down during a session. There is no loss of data when BMR is used to restart the Bridgemate software.

Special note: If Bridgemate use was not enabled as shown in item 1 above, BME  Enabls this section for Remote

there will be a BME command visible. This should be used to “enable” the BMO P ot
Bridgemate Scoring System for each section in the game. -
akK Cancel

Read data from the Bridgemate Scoring System into ACBLscore.
» The ACBLscore screen is normally visible on the PC, and the BCS screen is minimized.
» When you first key F11 (or F9) the keyboard may appear to be inactive. Use the mouse (or touch pad) to

move the cursor within the ACBLscore screen and left click. This will normally enable/activate the keyboard.

Player Numbers

If Player Numbers are to be entered at each table, this will be done as each table starts to use a Bridgemate.
After play has started, names are read from the results file into ACBLscore — using the BMN command.

Key F11 > B> M > N -or- F11 = End & highlight the BMN command line; Press ENTER
Special Note: In multi-section games the BMN command must be issued separately for each section.

ACBL Life Members enter their alpha character as a number. J=1, K=2, L=3, M=4, N-5, O=6, P=7, Q=8 &
R=9. A “Life Master ACBL Alpha = Number” file is on the www.bridgemate.us/user guides.php website.
There is a Life Master ACBL Alpha=Number label on the bottom of each Bridgemate.

Non ACBL member “pseudo” numbers: When there are regular players who are not ACBL members, each
non-member may be assigned a pseudo number that may be used. Pseudo numbers are in the ACBLscore
database preceded by the “#” character. For example: Player number 19 will be “#19” in the database.

For each number found in the “Club” or “Tournament” database, the player’'s name will be entered into the
Player Names (F3) file. If a number (ACBL member or pseudo) is not found — or no number has been
entered — there will be no entry made in the file for that player.

The BMN command will be available whenever ACBLscore’s Bridgemate Options is configured to “Allow
entry of player numbers at remote.” ACBL member numbers as well as non-member “pseudo” numbers are
read into ACBLscore and entered in the Names (F3) file. The BMN command must be executed separately
for each Section in a session. If the ‘Auto Strat when posting names from remote’ option is checked, a strata
will be assigned to each pair based on the players masterpoints in your ACBLscore database; otherwise all
names (read in from Bridgemate) are entered in the Names file as strata “A” until the STRAT command is
run. The F11 > STRAT command is used to assign the correct strata to each pair.

Note: Use the F3 command to manually enter the names of new players and those without a number.

Use the up-arrow key to move into the player name field when there is only one player in a pair.

Before or after the “auto stratify,” manually enter the names of players not shown in the Player Names file.
With “Allow Auto Strat” — see page 36 — you will be prompted to confirm the strata for each pair.

Note: When using a Mitchell-Rover movement, the will be no opportunity for the “bump” team (that moves to

different tables) to enter their player numbers. Use F3 to enter the names of the “bump team” players.

View player numbers and names:

When ACBLscore is shown as the scoring program and the “Load player database after BMS command” is
checked (See Chapter 3, Scoring Programs, page 18), numbers entered by the players and the
corresponding names from the ACBLscore database will be shown on the BCS screen — “Players” tab.
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Board Results

Once boards have been played and the results recorded on Bridgemates, the information may be “posted”
into ACBLscore. Typically, this is done periodically throughout the game. This will also enable the scorer
(usually the director) to spot any anomalies that might occur.

The BMP command (F11 followed by B-M-P — or “End”) is to read board results from Bridgemate and post
them into ACBLscore. Posting will automatically stop at the end of the penultimate round — to accommodate
the preparation of a next-to-last round report. After the penultimate round has been posted, one or more
additional “post” commands are needed to read all of the final results. Ctrl-P is a shortcut for this command.

When posting results in a multi-section session you will see:
1 Post all sections configured for remote entry

2 Post only Section x 2 Post only Section C

If you wish to post only scores for the “active” session, _Ganoe |
- click on “2 Post only Section C” and click OK, n ¥ of secions 2 £ olevenia |
- press “2” and press Enter, or CLUB mode

- use the arrow keys to hlghllght the line and press ENTER. 2=Srares Fi=Names Fd=Leaders Fi=Recap F7=Change FB=List Fi=Set

Otherwise just press ENTER to post scores for all sections.

The ACBLscore screen displays the number of rounds whose scores have all been posted. After all of the
rounds being played are shown as “entered,” the section/game is over. Results and reports can be
displayed and printed using F4, F5 and/or F8 as desired.

Before a score has been accepted, the TD MENU can be used to separately assign an arbitral score [AVG —
(40%), AVG = (50%) or AVG + (60%)] for E/W and for N/S. Note: The cursor must first be on the Contr line.

Scores already accepted/recorded in a Bridgemate — but not yet posted into ACBLscore — can be corrected
using the TD Menu. See Erasing entry, chapter 5, page 27. Activate the TD Menu, press ‘3 Erase result,”
enter the board number and press OK. If the board has been played more than once at this table, you will be
prompted to enter the round number. The erroneous result is erased and players may enter the correct one.

[T ]

Scores already posted into ACBLscore must be corrected there. TO erase a score in ACBLscore — type “X
See page 24 for Special entries: Pass-out and board not played.

Quick Setup Tips

Early game/session setup:
Single or multi-section games/sessions may be set up early in ACBLscore. Extraneous information such as
expected movement, Event rating (stratification criteria), Event Information (Tournament data), etc., may be
entered before the stress of actual play being started. It is suggested ACBLscore be “preset” with fewer tables
than are actually expected in a single or multi-session game/session. Do not start BCS at this time.
> Then, when play is ready to start:

a) Use F9->5 Change movement parameters and change to the actual movement/tables/etc.
b) In a multi-section session, repeat the F9>5 Change movement parameters for each section.
c) After the all the movement[s] have been finalized, use F112>BMS to start BCS — and the session.

To setup a session (with one or more sections) more quickly, bypass the Select event rating

Change Movement after Game has started

11 A mmimendmbb s s Pl O

masterpoint portion of normal setup. Just select “13 No masterpoints.” L T DIy e

o rm

Later, ffter play has started, use “F9>10 10 masterpoint rating to create stratification
for the game/sections.

Select option (ESC to Exit)

Change posting method
Change number of played rounds
Change section letter and/or color

To the extent possible, each session/game should be as fully configured as WA

possible in ACBLscore before starting BCS. Movement changes can be

e maovement p arameters

rto a different average
Settie-breaking spread
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made in ACBLscore after the BCS program has been started — to accommodate the arrival of new player[s] or one-
or-more “no show” players. The ACBLscore manual more fully describes how to make changes.

Use F9->5 Change movement parameters. After the new parameters have been entered and accepted, ACBLscore
will automatically invoke a command to update the results file and effect the changes in BCS.

Always post all scores before making any movement changes in ACBLscore. Especially if adding pairs or
making special changes using EDMOV; post all scores using ‘F112>BMP’ or Ctrl-P — before making any

changes.

Note: When BCS is updated, there will normally be a “Report” & Report
screen displayed. This screen may “closed” or BCS will HoveRent updsted by sitemial progra —
automatically close it after 1 minute. o iy won Lo o e
Adding round Z2: 0K
When ACBLscore updates BCS, “deleted” table[s] or section[s] e
sometimes are not actually be removed. Thus, it is recommended dding ot 0
that any “deleted” table[s] and/or Section[s] be manually A
deleted/logged off in BCS to preclude possible confusion if someone pdaing movenens —oony rowsd 5 K
inadvertently activates a deleted-table or deleted-section Bridgemate. e ting rowma Lok
Adding round Z2: 0K R
Change before any Bridgemates have been used —

When the changes can be made before players have started entering
their member numbers and/or results, instruct players to delay any entries until the changes are made. After the
ACBLscore changes have been made and BCS has been updated, players may begin normal Bridgemate use.

Change after people have started member number and/or score entry

Ask players to hold up any further Bridgemate entries until the movement change has been completed.

If the movement change will move pairs around, player numbers will need to be entered manually, later. However, if
pairs remain at the same tables (even though they may now have different team numbers, e.g., when change from a
5 table Howell to a 6 table Howell, or a 6 table Howell to a 7 table Mitchell, ACBLscore BMN (Post Names from
Bridgemate) will correctly assign pairs to the correct tables — when the “member-number” option is being used.
Make the movement changes as noted above. ACBLscore automatically updates BCS with the new info.

Note: When BCS is updated, there will normally be an “update” screen displayed.

Replacing Bridgemate during play — Bridgemate logged on as the wrong table

See page 32 Replacing Bridgemate or See page 32 Bridgemate logged on as the wrong table

ACBLscore Tournament Setup

There is a special instruction sheet on how to configure ACBLscore to use the Bridgemate Scoring System at a
tournament. This may be downloaded from www.bridgemate.us/user guides.php or Bridgemate Flash Drive.

Procedures when using Player entry of Section/Table

Check each Bridgemate as it is placed on a table. Press the OK key; if the "Bridgemate II" screen appears, the
unit is ready for Section/Table input. If the display is anything other than "Bridgemate Il," reset the Bridgemate.

For multi-section games, the suggested procedure when placing Bridgemates on tables is to:
o wake with OK,
e press OK to go to Section/Table screen,
e use *+/-to select Section assigned to the table,
e press OK to put cursor on the Table line.

Now, when players start each Bridgemate, they will only need to enter the table number.


http://www.bridgemate.us/user%20guides.php
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Names Display for 1° Round Sit-out Pair[s]

When there is a sit-out pair (at a phantom-pair table), a special game set up is required in order to display the sit-out
pair's names on the Bridgemates. For more information, see Chapter 6 Showing player names.

Set up the game with every section as full tables, i.e., without any phantom pair[s].

Use BMS to start Bridgemate Control Software, in the normal manner.

Have the “sit-out pair[s]” (at the phantom-pair table[s]) enter their numbers as soon as possible.

After the sit-out pair’s player numbers have been entered at the phantom-pair table[s], go to ACBLscore and
change the movement (F9 > 5 Change movement) to reflect the phantom pair in each applicable Section.

¢ Names for the “sit-out pair[s]” will now display on the Bridgemates at the start of each round.

Special Reports

Play data may be copied from BCS and used to prepare special reports — such as a summary of the results of each
board played.

C Text to Tabl '
e See Creating Reports, Chapter 3, page 14 on how to copy play data

from the BCS screen. Table size

Murmber of columns: 7
e EXCEL spreadsheet:
0 Paste the copied data into an Excel Spreadsheet.
o With the new data highlighted, select Data - Text to Columns
Select “Comma” as the delimiter.

¢ \WORD document:

Y
-
Mumber of rovs;

AutoFit behavior

o Paste the copied data into a Word document. Table style: (none)
o0 Highlight the new data, select Table > Convert > Text to Table Separate text at
Complete the “Convert Text to Table” screen as noted for O paragraphs (&) Commas
“Commas,” “AutoFit to contents” and number of columns in your O Tahs O Other:
data (7 is shown here).
0 The table that is created will be highlighted. Select Table > [ ok ][ cancl

Convert > Table to Text. This creates text which may be pasted
into an email message or uploaded to a website.

e OpenOffice.org: A simpler procedure is to use the spreadsheet program of OpenOffice.org which is “free to
download, use, and distribute” at http://download.openoffice.org/
0 Paste the copied data into the OpenOffice.org calc spreadsheet. On the “Text Import” screen that will

0 Adjust column widths — if desired.
o0 Highlight and copy the data for your report.

It is suggested the BCS column heading “NS/EW” be changed to Declarer. Below is a sample report.
Note: This example includes the “Lead” card which may be captured when options are controlled by BCS.

Section Board NS EW Declarer Contract Result Lead
A 1 2 3 N 4 H -2 H4
A 1 3 5 N 4 H -2 H4
A 1 4 7 S 3 NT -1 SJ
A 1 5 9 N 3 H -1 H4
A 1 6 2 S 3 NT -3 DA
A 1 7 4 N 4 H -1 c2

Expanded detail available on Websites.

With the Bridgemate Scoring System more detail is available about each board than the limited information from
ACBLscore. The Declarer, Contract and actual result — when coupled with ACBLscore info — provides players with
more information than ever before. The detail is even more significant with pre-dealt hands using a Dealer4 or
Duplimate dealing machine. Also, makeable contracts may be added to the display when using DealMaster Pro.


http://download.openoffice.org/
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Bridgemate.US has been working with two bridge-specific websites that are easily set up and controlled by a non
programmer. Our test sites are: www.waynesboro.bridge-club.org and www.bridgewebs.com/waynesboro/.

Visit www.bridge-club.org or www.bridgewebs.com to review their offerings and pricing. Both offer a trial period.
When a game is finished, it is very easy to upload 2 files (3 — with pre-dealt hands) and the result is immediate.

Several clubs/units have developed their own software for their own websites. Also, ACBL offers a “Clubs Results”
service for ACBL Sanctioned clubs.

Using Bridgemates Il and Bridgemates Pro together

If you have both a Bridgemate Pro and a Bridgemate Il system, it is possible to use both systems together to score a
single event. As Bridgemates Il only communicate with a Bridgemate Il USB server and Bridgemates Pro only with a
Bridgemate Pro ‘serial’ server, it is a requirement that both servers are connected to the computer.

To use both Bridgemate Pro and Bridgemate Il in one event:

1. Connect both a Bridgemate 1l USB server and a Bridgemate Pro serial server to your computer. The
Bridgemate Pro server can be connected through the USB-to-serial “dongle.” Please refer to the Bridgemate
Pro manual for operating instructions of the Bridgemate Pro server.

Start the Bridgemate system from your scoring program. This will start the Bridgemate Il system first.

After BCS has been loaded and Bridgemates Il have been activated, click on Session - Run Bridgemate
Pro concurrently. This will load a second copy of BCS and this copy will start the Bridgemate Pro server.
Both systems may now be used together.

4. When the session is finished, manually close both instances of BCS.

wn

Please keep in mind the following when working with both systems together:

o All tables will be loaded into the Bridgemate Il server and the Bridgemate Pro server. You decide which
tables will use Bridgemates Pro, and which will use Bridgemates Il. As a consequence, the Bridgemate “II
BCS” and the “Pro BCS” will show that certain tables are not activated yet in the Il or Pro server, since these
units are logged into the other server.

¢ You may wish to use Bridgemate Pro’s and II's in separate sections, e.g., Section A uses Bridgemates Il,
and Section B uses Bridgemates Pro. However, the units may even be “mixed” within a Section.

e Scores are exchanged between the two systems. Scores entered in Bridgemate Pro will also appear on the
Bridgemate Il scoring devices, and vice versa.

¢ A scoring-program movement update will first be carried out by Bridgemate Il, and a few seconds later by
Bridgemate Pro. This is done automatically.

o |If the second instance of BCS is accidently closed, it can be started again by using the same BCS menu:
Session - Run Bridgemate Pro concurrently. It will remember that it has already been started before and
will not start from round 1 but instead continue from where it was when the program was closed.

e Since Bridgemate Il has more settings than Bridgemate Pro, Bridgemate Pro will only use those settings that
are for Bridgemate Pro. For example, names may appear on Bridgemates Il but will not on Bridgemates Pro.


http://www.waynesboro.bridge-club.org/
http://www.bridgewebs.com/waynesboro/
http://www.bridge-club.org/
http://www.bridgewebs.com/
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Declaration of Conformity

Federal Communication Commission Declaration of Conformity (DoC) Statement

Responsible party: Bridge Systems BV

Address: Postbus 21570, 3001 AN, Rotterdam, The Netherlands
Hereby declares that the product:

Product Name: Bridgemate® Il Wireless Scoring System .

Table Terminal: 1l Model No: BM2-1 FCC ID: UVIBM21

Server: USB -1l Model No: BMS2-1  FCC ID: UVIBMS21

Conforms to the following regulations: FCC part 15, subpart B, section 15.47

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15
of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and receiver.

¢ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

e  Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This
device may not cause harmful interference, and (2) This device must accept any interference received, including
interference that may cause undesired operation.

Caution:
Any changes or modifications not expressly approved by Bridge Systems BV could void the user's authority to
operate the equipment.

Canada Regulatory Compliance Statement

This device complies with Industry Canada Standard RSS-210. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

Ce dispositif est conforme avec la norme CNR-210 d’Industrie Canada. Le fonctionnement du dispositif est sujet aux
deux conditions suivantes: (1) le dispositif ne doit pas causer de brouillage, et (2) le dispositif doit accepter tous
brouillages, incluant tous brouillages.

Table Terminal: |l IC: 6946A-BM21
Server: USB -1l IC: 6946A-BMS21

July 2011
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